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1 Warnings 

This section provides warnings regarding elements of the Indago system, and outlines steps to 
take when facing inherent dangers associated with operating Small Unmanned Aerial Systems 
(SUAS). 
 

1.1 Spinning/Sharp Propellers 

 
 
The propellers on the Indago system are extremely efficient and precision formed from carbon fiber, 
making the blades very stiff and sharp. Spinning at any speed are very dangerous and can inflict serious 
bodily injury.  

Warnings 
• Never approach the vehicle while blades are spinning.  
• Always be aware of people handling the vehicle and others in the area.  
• Establish open communication between the operator and any assistants to ensure the vehicle is a safe 

distance from people before arming the motors. 
• Never work on a vehicle with mounted blades. 

Propeller replacement is necessary when either blade is damaged in any way. Damaged or otherwise 
compromised blades are a hazard as they may fragment at high speeds. Even blades with small dings or 
scratches need replacement as they introduce large dynamic loads from vibration that can affect vehicle 
stability and degrade certain components.  

See Section 3.3.1 Propeller Replacement for instructions on proper propeller care and replacement.  
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1.2 Radio Frequency (RF) 

 
To satisfy Federal Communications Commission RF exposure requirements for mobile transmitting 
devices, a separation distance of 23 cm or more should be maintained between the antenna of this device 
and persons during device operation. To ensure compliance, operations at closer than this distance is not 
recommended.  

1.3 Batteries 

                           
 
The Indago battery and Handcontroller battery are high-density lithium batteries. These batteries provide 
maximum energy storage in a light-weight package.  

Warnings 
• If not handled or charged properly, lithium polymer batteries may explode or catch fire. The most 

common cause of battery fires are from punctures to the battery. 
• While the Indago battery is protected by a Kevlar/Carbon shell, care should be taken to avoid physical 

damage.  
• Lithium polymer batteries should never be fully discharged as this damages the battery and 

recharging could lead to a fire.  
• Avoid fully discharging the Indago battery by removing the battery from the vehicle promptly after 

flight.  
• Never leave a powered vehicle unaccompanied.   
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2 System Overview 
This section provides an overview of the Indago system including specifications for the 
Handcontroller, Virtual Cockpit, charger, batteries, payloads and peripherals. 

2.1 Indago 

 
 
 
 
 
 

  



 

Copyright © 2014 Lockheed Martin Corporation 

All Rights Reserved 
2-2 

 

 
 

 

Indago Specifications 
Endurance 45 minutes (w/200g payload) 
Payload Multiple Hot-swappable Payloads 
Range 2 km line of sight—5 km plus with optional long range antenna 
Dimensions 32x32x9 in (12x9x7 in folded) 
Weight 4.85 lb (2,200g) with 200g payload 
Operational Altitude 10-500 ft AGL (typical) 
Ground Control Station Touchscreen Handcontroller or laptop-based Virtual Cockpit 
Maximum Climb Rate 800 feet/minute 
Maximum Decent Rate 400 feet/minute 
Maximum Cruise Speed 30 mph 
Maximum  11,000 feet MSL 
Operating Temperature -30° to 120° F  
Rain Performance Moderate Rain (<7 mm/hr) 
Wind 25 mph 
Humidity 100% non-condensing 
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2.2 Handcontroller 
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Handcontroller Specifications 
Average Battery Run Time 4 hours 
Processor Quad Core 1.2 GHz 
Screen 1024x768 daylight readable touchscreen 
Dimensions 12x8.5x3 in 
Weight 4.25 lb 
Range 2 km line of sight—5 km plus with optional long range antenna 
Operating Temperature -30° to 120° F 
Rain Performance Moderate Rain (<7 mm/hr) 
Humidity 100% non-condensing 
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2.3 Virtual Cockpit 

 
 

 

Virtual Cockpit Minimum System Requirements 
Processor 700 MHz Intel Pentium III processor or faster (faster CPU needed for 

video recording) 
Operating System Microsoft Windows XP or later 
Minimum RAM 512 MB 
Minimum Free Disk Space 200 MB 
Video Card DirectX 8 compatible (or higher) Video Card with minimum 8 MB of 

Video RAM 
Direct X DirectX 9.0c August 2007 runtime (included with installer) 
Installation Requirement Must be connected to the internet 
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2.4 Charger 

 
 
 

Charger Specifications 
Dimensions 9.75x8.5x4.5 in 
Weight 4.2 lb 
Input DC Voltage Range 10-28 VDC (at least 24V to charge HC battery) 
Input AC Voltage 120 VAC 
Maximum Output Current 20 Amps 
Operating Temperature -30° to 90° F 
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2.5 Battery 

 
 
 

 
 
 

Battery Specifications 
Capacity 4s 11,000 Mah (162.8 Wh) 
Maximum Operating Voltage 16.8V 
Minimum Operating Voltage (under load) 13.8V 
Weight 870g 
Dimensions 7x2.5x1.875 in 
Max Charge 2C (22 Amps) 
Max Discharge 5C (55 Amps) 
Temperature -30°/+120° F 
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2.6 Payloads 
2.6.1 Duo Overview 

 
 
 

Duo Gimbal Specifications 
Weight 180g 
Dimensions 3x3.25x3.5 in 
EO Camera Resolution/Zoom NTSC /10x Optical; 4x Digital 
IR Camera Resolution/Zoom 640x480/8x Digital Zoom 
Elevation Travel Limit +20°/-110° F 
Active/Passive Image Stabilization Yes 
Water Rating Water Resistant 
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2.6.2 Pentax 

 
 
 

Pentax Payload Specifications 
Weight 200g 
Dimensions 3.25x5x2.25 in 
Camera Resolution/Zoom 14 Megapixels/5x 
Full HD Capture Rate .68 frames/s 
Shutter Speed 1/1,500 to 1/4 
Shockproof/Dustproof Yes 
Water Rating: Camera/Chassis Water Resistant 
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2.6.3 Agriculture Gimbal Overview 

 
 
 

Agriculture Gimbal Specifications 
Weight 120g 
Dimensions 3.3x3.3x3 in 
Aspect Ration 1.383 
Horizontal Field of View 43.36° 
Elevation Travel Limits +67°/-120°  
Roll Travel Limits +20°/-20°  
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2.7 Peripherals 
2.7.1 Long-range Antenna Kit 

 
 
 

Long-range Antenna Specifications 
Kit Weight 3.9 lb (1770g) 
Frequency  1080-1200 MHz  
Gain  8 dBi 
Horizontal Beam Width 75° 
Vertical Beam Width 65° 
Impedance 50 Ohm 
Max. Input Power 25 Watts 
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3 Indago Details 

This section provides an in-depth look at the Indago airframe and essential procedures for 
unpacking/ packing, payload swapping, general maintenance/repairs, battery care, preflight 
operations, and updating the Kestrel 3 Autopilot firmware. 

3.1 Unpacking/Packing 
Unpacking 

 

 
 

 
Step 1. Step 2. 

1. Open the soft carry case zipper with one hand while supporting the bottom of the case with the other.  
a. Open the case slightly to check whether the Indago is right side up. 
b. If upside down, flip the case over while holding the case firmly to prevent it from opening.  
c. Fully open the case and remove the vehicle using both hands supporting its sides.  
d. Warning: Be aware that the antennae and propellers are sharp and can cause injury. 

2.  With the Indago removed from its case, grab hold of the two motor pods attached to the front of the 
vehicle.  

a. Unfold the vehicle by these pods and pull them toward you to snap them in place.  
b. Be sure to keep hands and fingers clear of the gap between the arm clips and arm bases to 

avoid getting pinched.  
c. The back two arms are likely to swing down and away from the user. 

  
Step 3. Step 4. 
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3. Rotate the Indago and grab hold of the next two motor pods and snap them into place in the same 
manner. 

4. Hold the landing gear legs underneath the arms of the Indago, and pull them down and snap them into 
place. Do this for all four arms.  

  
Step 5. Step 6. 

 
5. Next, spread the blades apart.  

a. They don’t have to be perfectly straight because they will self-align once the motors spool up.  

6. Identify the front of the Indago by the knurling and split on the arm base. 

  
Step 7. Step 8. 

7. With both hands, use both thumbs to press on the knurling to open the battery hatch.  
a. Keep hands clear of the antennas. The vehicle will swing down on the hatch hinges.  

8. With the hatch open, pick up a battery by its strap and slide it into the battery bay. 
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Step 9. Step 10. 

9. If the power connector on the battery is facing the bottom, the vehicle will be powered.  
a. If the power connector on the battery is facing the top of the vehicle, it will be stored in the 

vehicle without powering the vehicle. 

10. The battery bay can now be shut.  
a. Support the vehicle body with one hand while shutting the hatch with the other hand.  
b. Be careful to keep fingers and hands clear from the openings as you close the hatch to prevent 

pinch hazards.  

Packing 
To pack the Indago, remove the payload and power off the vehicle. The battery can be either removed or 
rotated for unpowered storage in the vehicle.  

  
Step 1. Step 2. 

11. After storing or removing the battery, fold the blades together for each arm.  
a. Then, fold each of the legs back down to each arm. 

12. While supporting the vehicle with one hand, use the other hand to grip the motor and blades.  
a. The objective is to hold the blades so they don’t strike the body as the Indago arm is 

unclipped.  
b. Users may use their leg to support the end of the vehicle while folding the arm. Be sure to 

have the antennas bent along the leg to avoid cuts. 
c. Apply moderate force to pop the arm out of its retaining clip. 
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Step 3. Step 4. 

13. Collapse the arm on the other side while supporting with the user’s other hand as shown. 

14. The vehicle can now be rotated and the other two Indago arms collapsed.  
a. If the Indago arms seem to flop too easily making packing and unpacking difficult, the bolts 

that pin the arms in place can be tightened to provide friction to the joints. 

  
Step 5. Step 6. 

  
Step 7. Step 8. 
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15. The completely folded vehicle can now be inserted into the soft case.  

16. The back of the vehicle is inserted first. 

17. Seat the unit firmly into the foam at the bottom of the case. 
a. The antennae are comprised of a memory shape alloy so they can be bent while inside the 

case; upon removal from the case the antennae return to shape. 

18. With the Indago properly seated in the soft case, the case can now be zipped closed.  
a. The front antennas automatically bend out of the way. 

3.2 Payload Swapping 
Payloads designed for the Indago are equipped with a quick detach mount and are hot swappable. This 
means payloads can be changed while the vehicle is powered. Payloads are also programmed with their 
own configuration data, which tells the autopilot how to set them up without the user having to do 
anything.  

• The payload should have a red index mark on the front.  
• The payload quick detach under the vehicle also has a red mark.  
• These marks need to line up in order for the payload to drop into the quick detach mount.  
• The payload will go in only one way.  
• Avoid touching the lenses of payloads in order to avoid smudging or scratching them. 

  
Step 1. Step 2. 

1. With the vehicle upside down, locate the red marks and insert the payload.  
a. Once the payload drops into the mount, twist the payload clockwise.  
b. The user will feel a click and resistance to further twisting when it is fully locked in.  

2. The payload is removed in the reverse operations and a new payload can be swapped in. 

3.3 General Maintenance/Repairs 
3.3.1 Propeller Replacement 
Propeller replacement is necessary when either blade is damaged in any way. Damaged or otherwise 
compromised blades are a hazard as they may fragment at high speeds. Blades with small dings or 
scratches also need replacing as they introduce large dynamic loads from vibration that can affect vehicle 
stability and degrade certain components.  

ALWAYS replace both blades of a propeller as they are factory matched sets and balanced to provide 
low-vibration operation. 
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NOTE: The user can identify the direction the propellers should spin by looking for the smooth curved 
side as an indication for the front of the blade. The trailing edge of the propellers is identified by the 
sharper corners. Also, the front side of the blade is sloped higher than the back side of the blade when 
installed right side up. 

 
 

3.3.2 To Remove a Propeller Set 

 
 

Step 1. Assembling. Step 1. Assembled. 

1. Unscrew the hand prop-nut by rotating counter-clockwise. Lift the carbon prop-plate and individual 
blades vertically off the prop-pins.  

a. DO NOT attempt to remove the prop-pins as they are thread-locked into place.  

NOTE: Each motor requires a specific directional propeller. The rotation direction is indicated by an 
arrow located on the top side of each arm clip. See Section 2.1 Indago for the motor and prop directions. 
Select the appropriate direction blade-set by matching the direction of the blades with the arrow direction 
located on the top side of the arm clip. 
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• Ensure both blades have the SAME rotation and are installed on the motor right side up.  
• Check that the prop-plate is free from debris then fit over the two blades on the prop-pins.  
• Fasten the hand prop-nut onto motor shaft by rotating clockwise until it seats against the prop-plate. 

 
Step 2. 

2. Tighten prop-nut until the blades do not swing freely when vehicle is turned sideways but are still 
easily folded by hand. Appropriate blade pressure is important to flight stability. Check blades for 
smooth pivoting action.  

3.3.3 Arm Replacement 
Arm replacement is necessary when any arm component, such as a motor or carbon tube, is damaged.  

  
Step 1. Step 2. 

 

Motor and 
prop 

direction 
arrow 



 

Copyright © 2014 Lockheed Martin Corporation 

All Rights Reserved 
3-8 

 

1. To remove an arm, first fold the damaged arm as if for storage to expose the wire connector.  
a. Remove the wire retaining O-ring on the arm clip.  
b. Use a 2 mm hex driver to loosen the wire connector screw until it spins freely.  
c. Carefully back out the wire connector until free from the arm end.  

2. Finally, loosen the clamp bolt on the arm clip with a 1.5 mm hex driver and slide carbon tube out of 
the arm. 

 
Step 3. 

3. An arm may be installed by first orienting it motor up, and sliding the carbon tube into the arm clip.  
a. The carbon tube is slotted, so it must be rotated slightly until aligned with the arm clip keys 

before seating completely.  
b. Ensure tube is fully seated into the arm clip by visually inspecting the inside end of the arm 

clip.  
c. Secure the arm tube by tightening the clamp bolt with a 1.5 mm hex driver.  
d. Carefully seat wire connector into arm clip end and tighten with a 2 mm hex driver.  
e. Be sure wire connector is seated fully before tightening as misaligned connectors can bend 

and break the mating pins.  
f. Replace wire retaining O-ring and check wire clearance with hinge point.  

3.3.4 Arm Clip Replacement  
Arm clip replacement will need to be done if any arm clips are broken or damaged. 

1. Follow Steps 1-2 on Section 3.3.3 Arm Replacement to remove the arm from the damaged arm clip. 

2. Unscrew and remove the hinge bolt with a 2.5 mm hex driver. 
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Step 2. 

3. Remove the arm clip and replace it with the same numbered arm clip appropriate for that arm 
position. 

NOTE: The arm clips are numbered on the bottom side with the number that corresponds to their arm 
location. See Section 2.1 Indago for the arm numbers. 

4. Reinstall the arm following Step 3 as shown in Section 3.3.3 Arm Replacement. 

3.3.5 Landing Gear Replacement 

  
Step 1. Step 2. Pulling off the Landing Gear Clamp. 

The entire landing gear assembly is attached to the carbon arm tube by a single 2 mm bolt.  

1. Remove this bolt with a 1.5 mm hex driver to remove the leg and clip.  

2. Remove the landing gear clamp by carefully flexing the opening wider and pulling it off.  

NOTE: The clamp has a rubber insert that must remain aligned inside the clamp to seat properly and 
provide resistance to twisting.  
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Step 2. (Note) View of Rubber Insert. Step 3. 

3. When reassembling the landing gear, install the clamp with the flat face against the motor pod. 

3.4 Indago Battery Pack 
The Indago battery pack is designed to give the highest flight time with currently available technology as 
well as smart monitoring of the battery’s performance and health (see Section 6.7.5 Battery Monitoring). 
Proper care and storage will extend the battery’s performance and usable life (see Section 7 Charger for 
details on proper charging, storage and care).  

The battery can be inserted two ways:  

1. When inserted with the connector down, the vehicle will be powered.  

2. When inserted with the connector up, the battery will not power the vehicle and can be left stored 
inside the battery bay.  

The battery includes an LCD fuel gauge that displays the charge level. See Section 2.5 Battery to view 
values of LCD fuel gauge. 
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3.5 In-depth Preflight Inspection 
Before each flight, it is important to inspect the Indago system for damage, loose parts and wear. The 
Indago is a highly optimized vehicle that may not function properly or safely with damaged components.  

3.5.1 Vehicle Hardware Inspection 

 
Step 1.  

 
Step 2. 

1. Check each arm wire harness at hinge point for binding and wear. 

2. Ensure wire connector is fully seated and secure. 

 

 

 
Step 3.  Step 4.  

3. Inspect all propellers for damage including dings, scratches, cracks or crushed midsections. 
a. Always replace both blades of a damaged propeller as they are specifically factory matched. 

4. Check propeller root friction by pivoting each blade about the pin.  
a. Proper friction is obtained by adjusting the hand prop-nut until the blades just barely stay in 

place when the vehicle is held sideways. Ensure prop-nut is firmly in place. 
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Step 5. Step 6. 

5. Check proper propeller direction on each motor. The direction of each blade should match with the 
direction arrow on the top inside face of the arm clip (see Section 3.3.1 Propeller Replacement for 
more detail on identifying propeller direction and how to tell they are installed right side up). 

6. Spin each motor bell to ensure there is no resistance or binding.  

a. Encumbered rotation could be a result of debris in the motor or a sign of a damaged motor 
bell. 

b. Use compressed air to blow out dirt and other foreign matter from between the rotating bell 
and stationary stator. 

 

 

 

 
Step 7. Step 8. 

7. Pull up on each motor bell to make sure it doesn’t pull off from its base. This is to check that the 
retaining clip on the motor shaft is still intact. 

8. Ensure that all landing gear legs and vehicle arms are fully extended and locked into place. 
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9. Inspect all vehicle hardware to ensure nothing is missing or loose, including:  

 

 

 

 

 
Step 9a. The three motor pod screws on each arm. Step 9b. The landing gear bolt on each arm. 

 

 

 

 
 

 

 
 

Step 9c. Arm clip clamp bolt on each arm. Step 9d. Arm clip pivot bolt on each arm. 
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Step 9e. All four shell screws. Step 9f. The two battery hatch hinge bolts and 
nuts. 

 
 

 
                 

 

 

 

 

 
  

Step 10. Step 11. 

10. Inspect battery compartment for foreign objects and debris. 

11. Ensure payload is properly and fully seated (if necessary). 
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3.6 Updating Kestrel 3 Autopilot Firmware 
The Kestrel 3 Firmware Utility is used to copy a new firmware image onto the Kestrel 3 Autopilot. 
Firmware images are delivered as *.ldr files – for example, Kestrel3 Firmware Proc Heli.ldr. 

3.6.1   Quick Guide 
To copy a firmware image onto the Kestrel 3, perform the following 10 steps. For more details, see the 
section that follows. 

1. Use the Kestrel programming cable to connect the Kestrel 3 Autopilot to the computer. 

2. Connect the green wire on the programming cable. 

3. Power up the Kestrel 3. 

4. Launch the Kestrel 3 Firmware Utility. 

5. Select the serial port used in Step 1. 

6. Leave the Use Default checkbox under Pre-loader Info checked. 

7. Specify the desired firmware image in the File: edit box under Firmware Image Info. 

8. Press the Load button and wait until the Status box at the bottom states Success! 

9. Disconnect the green wire on the programming cable. 

10. Reboot the Kestrel 3. 
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3.6.2   Details of the Process 
The Kestrel 3 Firmware Utility, with the main functional groups highlighted in different colors, is 
displayed below. The descriptions that follow refer to different parts of this image. 

 
Kestrel 3 Firmware Utility. 

 

3.6.3 Updating the Firmware 

  
Step 1. Step 2. 

1. Before a firmware image can be copied to a Kestrel 3, connect Kestrel to the user’s computer with the 
Kestrel programming cable.  

2. Remove upper Kevlar shell. 
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Step 3. Step 4. 

3. Plug the programming cable into the Ser 1 port on the Kestrel 3.  
a. The programming cable’s green wire should be connected. 

4. Power up the Kestrel 3. 
a. Launch the Kestrel 3 Firmware Utility using K3 Firmware Utility.exe. This program copies 

the firmware image to the Kestrel 3. 

5. Configure the serial port to communicate with the programming cable attached in Step 1.  
a. The Serial Port dropdown (green in the image above) lists all the serial ports on the computer, 

and can be used for this purpose. 

6. The Firmware Utility needs to be told which firmware image should be copied to the Kestrel 3. Use 
the Firmware Image Information Group (purple in the image above) to do that. Kestrel 3 firmware 
image files have a *.ldr file extension that is several hundred kilobytes in size. 

a. To select a firmware image, press the “…” button in the purple Firmware Information group. 
For verification purposes, the firmware file’s date and time are displayed. 

7. Perform the firmware image copy by pressing the Load button. 
The copy happens in three stages, all of which happen automatically when the Load button is pressed. 
• Stage 1 – Establish communications with the Kestrel 3 and put it in Boot Mode. This stage usually 

takes 1-10 seconds, and prepares the Kestrel 3 to receive the small pre-loader. You can tell that the 
Kestrel 3 is in Boot Mode when all its LEDs are off, except for the yellow Power light. 

• Stage 2 – Copy the pre-loader to the Kestrel 3 and launch it. This usually takes 5-10 seconds. During 
this stage, the Kestrel’s Com LED will flicker dim red and the Status Information Group (yellow in 
the image above) will show how the copy is proceeding. 

• Stage 3 – Copy the firmware image file to the Kestrel 3. This takes 5-10 minutes, due to firmware 
image file sizes. As in Stage 2, the Kestrel’s Com LED will flicker dim red during copy; the Status 
Information Group (yellow in the image above) will show how the copy is proceeding. 

Note that the load should not be interrupted at this point or Kestrel 3 could be in an unbootable condition. 
• To correct this, use the K3 Firmware Utility to copy the firmware image to the Kestrel 3 again. 
• When the copy is complete, the Status field (at very bottom of yellow Status Information Group) will 

indicate: Success! Firmware copied onto Kestrel!  
8. Disconnect the green wire on the Kestrel 3 Autopilot programming cable and reboot the Kestrel.  

a. The Kestrel 3 should boot normally, with the Com and Sys LEDs blinking red. 

9. If the Kestrel does not boot, make sure the programming cable’s green wire is disconnected.  
a. If that does not remedy the issue, repeat the copy process. 
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4 Handcontroller Details 

The Handcontroller enables functions for Indago mission planning, system monitoring, payload 
operation, and manual control in one hand-held device. This section describes Handcontroller 
hardware, user interface, and general operation. 

4.1 Handcontroller Overview 
4.1.1 Mechanical 
The Handcontroller is designed with mechanical switches and joysticks for use in various ways during 
Indago flight operation. The figures below provide a pictorial description, while the table lists 
Handcontroller components and their functions.  

 

 
Handcontroller Switches and Joysticks. 
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Handcontroller Functions 
Joysticks Give the operator manual flight control of the Indago in Handcontroller guidance 

modes. 
Sliders Allow the operator to manually control the gimbal payload orientation. 
Mode Switch Activates manual Handcontroller guidance modes. 
Function Switch Determines D-Pad functional options. Also momentarily displays the Aux button 

functions on the main window. 
D-Pad Performs various operational functions (e.g., menu navigation, payload 

interactions, initiates flight modes, etc.).  
Aux Buttons Assignable buttons that allow the operator to execute a variety of functions (e.g., 

payload interactions, etc.). 
Arm Button Allows the operator to arm and disarm the Indago motors. 
Power Button Powers on and off the Handcontroller. The internal blue LED indicates that the 

Handcontroller is on when persistent and blinks when off to indicate charging. 
 
 
4.1.2 Connectors 
Handcontroller connectors are located at the bottom of the device behind water-resistant flaps as pictured 
below. Connectors listed from left to right are:  

• Power barrel connector (11-30V DC) 
• Head phones 
• Composite video out/in jacks 
• Ethernet 
• HDMI out 
• USB mini (AB) for connecting a device 
• USB B for connecting to a computer 
• Auxiliary Sub D 
• SD card slot for loading maps and recording video 

 
Connectors. 
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4.2 Handcontroller User Interface 
The Handcontroller user interface provides the operator with critical system information, live Indago 
payload video, map of the operational location, and mechanisms for user input (touchscreen buttons and 
gestures as well as mechanical switches). The image below shows a diagram of the Handcontroller user 
interface and its components, which are detailed in the following sections.   

 
Handcontroller User Interface. 

 
4.2.1 Windows and Touchscreen Buttons 
A map and video window for operator situational awareness (see above picture) are displayed in the top 
left and bottom right of the user interface. In the above picture the video window is small and the map 
window large. Note that the video and map window location and size are easily swapped by simply 
pressing on the smaller of the two windows in the touchscreen.  

Six touchscreen buttons located above the main window (i.e., larger of the two windows) are provided to 
the operator. A set of six buttons is dedicated to both the map and video windows. These two sets of six 
buttons are interchanged when the map and video windows are swapped.  

The touchscreen buttons are assignable, providing the operator easy access to functions associated with 
monitoring either the Indago’s video feed or the map. 

Interacting with the Map and Creating a Flight Plan 
The map window icons indicate the location of the Indago, Handcontroller, home, and waypoints as 
shown in the figure below. Note that the current waypoint is highlighted red.  

To interact with the map and create and edit a flight plan, press the touchscreen Edit button. In this mode, 
the map no longer centers on the Indago but can pan with a finger drag. In addition, flight plan waypoints 
can be added or edited with a double click on the screen.  

 

Large Map Window 

Small Video Window 

Side Bar 

Health Bar 

Touchscreen 
Buttons 
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Handcontroller Map Window with Flight Plan. 

To move an existing waypoint: First select the point with a long sustained press and then drag the point 
with a finger.  

• A selected waypoint is indicated with a yellow ring (see the above picture).  

To unselect a point: Simply click on the map in any location other that the highlighted waypoint. The 
home location can be moved in the same manner.  

Series: Waypoints can be inserted into a series of points by first selecting the point prior to the waypoint 
that is intended to be inserted.  

• For example, if one intends to insert a point after waypoint number 2 then point 2 should be selected.  
• At this point, the operator can double click on the screen at the desired location to insert a waypoint.  

Editing Waypoints 
An existing waypoint can be edited by double clicking on the desired waypoint.  

At this point, the waypoint editor appears (see picture below). This editor allows the operator to set the 
waypoint type; set the selected waypoint to the current waypoint; delete the selected waypoint; and set 
altitude, airspeed, heading, and dwell time. 

Home 

Current 
Waypoint 

Handcont- 
roller 

Indago 
Location 

Selected 
Waypoint 
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Handcontroller Waypoint Editor. 

The editor is dismissed by again clicking on any location on the map.  

All points can be edited simultaneously with the Edit All WP touchscreen button. Other touchscreen 
buttons that are used in conjunction with the map window are Upload and Download, which upload the 
flight plan on the Handcontroller to the Indago and download the flight plan on the Indago to the 
Handcontroller. 

When the video feed becomes the main window in the user interface the operator can point the payload by 
clicking on the video window. The Handcontroller provides several touchscreen buttons intended to be 
used with the video window.  
• Record: Starts and stops video record on the payload and Handcontroller 
• Snapshot: Takes a snapshot both on the payload and on the Handcontroller 
• Video Mux: Switches the video feed from one camera to another 
• FFC: Performs a flat field correction to calibrate infrared payload cameras 
The following table lists the touchscreen buttons. 

Touchscreen Buttons 
Edit Puts the map into edit mode, which allows operator to drag the map and edit the flight 

plan. 
Edit All WP Allows the operator to select and edit all of the waypoints at once. 
Upload Uploads the flight plan on the Handcontroller to the Indago. 
Download Downloads the flight plan on the Indago to the Handcontroller. 

Record Starts and stops video recording both on the payload if available and on the 
Handcontroller. 

Snapshot Takes a snapshot on the payload if available. In addition, the Handcontroller creates and 
image from the video feed. 

Video Mux Switches the video feed from one payload camera to another. 
FFC Performs a flat field correction to calibrate infrared payload cameras. 
Cancel Track Cancels a vision track if a Vision Processing Unit (VPU) is integrated on the Indago. 
Zoom Map Toggles between map zoom levels. 
Toggle LEDs Commands the Indago to toggle its LEDs (High, Medium, Low, Infrared, Off). 

Gimbal Mode Toggles the payload gimbal between POI (Point of Interest – geo pointing mode) and 
Stabilized mode. 
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4.2.2 Health Bar 
Handcontroller and Vehicle Health bars are given along the top of the user interface. These bars, 
contain several icons and text that indicate status of critical system components. The Handcontroller 
section includes indicators for Handcontroller battery life and GPS quality (outlined in red below). 

 

The vehicle portion indicates Agent number, flight state, battery life, communication quality, GPS 
quality, and vehicle altitude, speed, and heading. Note that the flight state indicator text will turn red 
in a state that corresponds to armed/spinning motors.  

 

 

4.2.3 Side Bar 
Message Window and Indicators 
Further status information is provided on the left side bar in the Message 
window. The top of the window gives the following quick view items:  

• Flight time (FltTm) 
• Distance to home (Dst2Hm) 
• Battery voltage (V) 
• Power draw (W) 
• Throttle (Thr) 

Below the quick view items in the Message window, warnings and critical 
messages are displayed to the operator.  

Three status indicator lights for vehicle motors (Mot), magnetometer (Mag), 
and general guidance, navigation, and control (Gnc) are placed below the 
Message window. 

Indicator colors communicate status to the operator (i.e., green – good, yellow 
– proceed with caution, red – unacceptable for flight).  

This is followed by two text boxes that indicate current flight mode (e.g., Land, Nav, etc.) and Gimbal 
Control mode. 
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D-Pad 
The Handcontroller includes a D-Pad for executing several functions via thumb 
press. These functions are grouped into three sets of five options: General, 
Payload, and Flight Mode.  

The function rocker switch on the back of the Handcontroller toggles the D-Pad 
between these groups:  

• Releasing the function switch (default mode) activates the General Functions. 
• Pressing the top side of the function switch activates the Flight Modes group. 
• Pressing the bottom side of the function switch activates the Payload 

Functions. 

A D-Pad indicator located at the bottom of the side bar indicates active functions 
that D-Pad executes with the associated press (i.e., up, down, left, right, center).  

Specifications 
The following tables list all available D-Pad General, Payload, and Flight Mode 
functions. 

General D-Pad Functions 
Menu Enters menu system.  
Zoom Map Toggles between map zoom levels. 
Display Toggle Toggles between large map small video, large video small map, and full screen 

video. 
Preflight/Failsafes When not airborne, executes the preflight sequence (Sensor Check, Zero 

Pressure, GPS Home, Joystick Check) and then displays the failsafe settings 
window. When not airborne, the option only displays the failsafe settings window. 

Health Displays the vehicle health window. 
 
 

Payload D-Pad Functions 
Snapshot Takes a snapshot on the payload if available. In addition, the Handcontroller creates 

an image from the video feed. 
Zoom In Gives a zoom in command to the payload. 
Record Start/Stop Starts and stops video recording both on the payload if available and on the 

Handcontroller. 
Zoom Out Gives a zoom out command to the payload. 
Pilot View Commands the payload to point straight forward and give the operator a pilot view. 
 
 

Flight Mode D-Pad Functions 
Hover Now Puts the Indago in the hover now mode, which causes the vehicle to stop and hover in 

its current location. 
Follow Me The Indago will follow the Handcontroller during flight with a given standoff distance 

and at the altitude in which the vehicle entered the mode. 
Home Initiates the Home flight mode, which causes the vehicle to fly to the home location at 

its current altitude. 
Land Puts the Indago in the Land Now flight mode, which will land the vehicle in its current 

location. 
Nav Initiates the Nav mode, which flies the uploaded waypoint flight plan. 
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4.2.4 Menu Navigation 
As indicated, a key D-Pad function is menu navigation. Handcontroller menus are organized into two 
groups: HGCS and Vehicle.  

Upon entering the menu system, the user selects a highlighted option with a right press and exits menuing 
with a center press. Up, down, and left presses navigate the menus as expected.  

The tables below list Handcontroller and Vehicle menu options. 

HGCS Options 
Modem Channel Allows the operator to set the Handcontroller modem channel. 
Modem Power Sets the Handcontroller modem power. 
Video Channel Sets the Handcontroller video receiver channel. 
Video Brightness Sets the brightness gain on the Handcontroller video feed signal.  
Backlight Brightness Sets the actual Handcontroller screen backlight brightness. 
Switch to External/ 
Internal Composite Video 

Switches the incoming video feed. 

Copy Map from SD Card Allows the operator to select a map located on the SD card and import it 
into the Handcontroller. 

Eject SD Card Saves any necessary information on the SD in preparation for an SD card 
eject. 

Show/Hide Lat/Long in 
Video 

Displays or hides text that gives the estimated latitude and longitude of the 
center video feed pixel. 

Turn Video Streaming 
On/Off 

Starts or stops streaming the video feed to the base computer. 

Show Version 
Information 

Shows the version information in the message window. 

Update Firmware from 
SD Card 

Updates the Handcontroller firmware based on files loaded onto an SD 
card and then restarts the Handcontroller. 

 
 

Vehicle Options 
Address Displays agent numbers that have recently communicated with the Handcontroller 

and allows the operator to select the Indago agent address for establishing full 
communications. 

Preflight Gives ability to manually perform preflight procedures (Sensor Check, Zero 
Pressure, Set GPS Home, Check Joysticks). 

Modem Channel Allows user to set the vehicle modem channel. 
Modem Power Sets the Indago modem power. 
 
4.2.5 Auxiliary Buttons 
Auxiliary buttons provide easy access to hard buttons while the user actively flies the Indago. These hard 
button functions are assignable to accommodate specific user mission needs.  

Function options are: Record, Snapshot, Video Mux, FFC, Cancel Track, Zoom Map, Toggle LEDs, and 
Gimbal Mode. These functions are described in the list of touchscreen buttons in Section 4.2.1 Windows 
and Touchscreen Buttons. 
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4.3 Establishing Communications 
The Handcontroller automatically selects and establishes communication with the first agent that responds 
to its ping.  

If the operator previously set the Indago and Handcontroller to matching modem channels, then 
communications should be established automatically. The user needs only to verify the agent number and 
communication quality.  

Setting Up the Vehicle and Handcontroller Communications 
The process for setting up the vehicle and Handcontroller for communication is: 

1. Power on the Indago by installing a battery. 

2. Turn on Handcontroller. 

3. Using the D-Pad menu system described earlier, set the modem channel of the Handcontroller to 
match the channel of the Indago. If the Indago modem channel is unknown, the user can try different 
channels. 

4. Once the correct channel is selected, the Handcontroller will automatically establish communications.  
a. If more than one agent is on a channel, the user may need to select the appropriate agent by 

navigating to the Vehicle->Agent menu 

5. The operator should verify the communication quality and agent number in the Health bar at the top 
of the user interface.  

a. For close but not too close line-of-sight range between antennas (5-50 ft), the 
communications icon should indicate full green bars.   

4.4 Receiving Video 
The Handcontroller automatically displays video if the video channel is properly set on the 
Handcontroller. The operator typically should only need to verify the quality of the video in the user 
interface.  

If the Handcontroller video receiver channel is not correct, the channel is changed using the menu system 
under HGCS -> Video Channel. 

4.5 Loading a Map  
1. Load maps into the Handcontroller via the D-Pad menu system from an SD card.  

a. A single map consists of a pair of jpeg (*.jpg) and world file (*.wf) files with the same name.  
b. These files can be created using the Virtual Cockpit Map Maker Application (see Section 5.7 

Creating and Loading Maps).  

2. Once created, place the maps on the SD card’s main directory.  

3. Insert the card into the Handcontroller SD card slot. 

4. Load the map into the Handcontroller by selecting the appropriate map under the D-Pad menu HGCS-
>Copy map from SD card option. 

4.6 Video Dissemination 
The Handcontroller allows for the operator to stream video from the controller to a base station computer. 
This requires installing VLC Media Player (or equivalent media player software) on the base station. Take 
the following steps to set up this feature. 
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Streaming the Video 

  
Step 1. Step 3. 

1. Open the base station computer’s wireless network utility and connect to WLAN-AP-HC##. 

2. Start the video stream from the Handcontroller by selecting HGCS->Turn Video Streaming On menu 
option using the D-Pad.  

3. Display the video on the base station computer by launching VLC and then selecting Media->Open 
Network Stream menu option. Type or select the following URL, and press play: 
udp://@192.168.168.101:3001. 

4.7 Updating Firmware 
Update Handcontroller firmware by loading files from the SD card using the D-Pad menu. Procerus 
provides update files contained in a folder labeled HandControllerUpdate_*. To load provided firmware 
updates: 

1. Load this directory, with all of its contents, onto the main directory of an SD card.  

2. Insert the card into the Handcontroller’s SD card slot.  

3. Load the firmware by selecting the D-Pad menu option HGCS->Update Firmware from the SD card.  

 



 

Copyright © 2014 Lockheed Martin Corporation 

All Rights Reserved 
5-1 

 

5 Virtual Cockpit Details 

This section introduces users to the main parts of the Virtual Cockpit (VC), describes parts and 
functions, and assists users in performing VC tasks. 

5.1 Virtual Cockpit (VC) Overview 
The VC is software that runs on a Windows® computer, and communicates with the Kestrel 3 Autopilot in 
the aircraft via radio modem (usually inside the Handcontroller). Generally, users perform day-to-day 
flight operations using the Handcontroller. However, users will perform advanced flight plans and low-
level configuration and setup of the system via the VC.  

The VC allows the operator to configure, monitor, issue commands to the Autopilot and Commbox, 
upload flight plans, and change waypoints, all while the vehicle is airborne. The VC is generally installed 
on a laptop computer for portability. 



 

Copyright © 2014 Lockheed Martin Corporation 

All Rights Reserved 
5-2 

 

5.1.1 VC Main Screen 
The figure below shows the VC main screen. It displays the most frequently used buttons and status information for flying the aircraft and for use 
during preflight. 

 
VC Main Screen. 
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Primary Elements of the VC Main Screen 
1. Indicator Lights – These give an overview of key vehicle systems status. 

2. FBW Display – Displays the current Fly By Wire (FBW) mode. Typical values are Manual, Altitude, 
Position, etc. 

3. Menu Bar – Drop-down menus give access to many of the frequently-used VC functions. 

4. Motor Armed Button – Arms the motors immediately before takeoff. Also displays the current 
Armed status. 

5. Flight State Display – Displays the current state of the aircraft’s mission. Typical values are 
Preflight, Disarmed, Airborne, etc. 

6. Mode Button Group – Used to set the Kestrel 3 Autopilot’s flight mode (Home, TakeOff, Nav, etc.). 
Also displays the current mode with a green highlight. 

7. Advanced Modes Group – Set of configurable buttons that lets the user put the Kestrel 3 Autopilot 
into advanced modes, like Pitch, Deep Stall, PID, Convoy, GPS Sim, etc. 

8. Payload Modes Group – Set of configurable buttons that lets the user control various payload 
functions. Also displays associated mode information. Note that most of the functions control 
cameras. 

9. Agent List – Displays information about the current agent, such as communications quality, battery 
voltage, altitude, etc. To select an agent, click anywhere on the row corresponding to the desired 
agent. The background will turn blue for the selected agent. 

NOTE: Screenshot at right shows two 
agents, with the first agent selected. Once 
an agent is selected, the VC interface 
corresponds with that agent. This 
includes all autopilot-specific setup 
screens, UAV Modes buttons, map 
overlays, Flight Plan, etc. 

 

10. Artificial Horizon – Indicates attitude and status information about the aircraft. 

11. Message Window – Shows informational, warning, and error messages about the system. 

12. Pre-flight Group – Contains buttons the operator uses to perform common preflight steps – Zero 
Pressure, GPS Home, Check Sensors, and FailSafes. 

13. Lower Map Pull-out – Controls for manipulating the Fight Plan, as well as a list of all the flight 
items. 

14. Right-hand Map Pull-out – Misc in-flight controls for the Kestrel 3 Autopilot and the vehicle. 

15. Map and Flight Plan Display – A graphical representation of the flight plan, superimposed over a 
map. 

5.1.2 Map and Flight Plan Display 
The Map Window occupies the center of the VC Main Screen. It monitors the position and navigational 
status of the aircraft and manages the flight plan. The Map displays the position of the agent and its flight 
items (Waypoints, TakeOff, etc.). It also shows status information, wind, gimbal position, etc., as shown 
in the figure below. Users can customize and configure the map using the F7 Map Settings window. 
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VC Map and Flight Plan Display. 
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VC Map and Flight Plan Display Functions 
1. The Aircraft – Icon shows the position and orientation of the aircraft and the direction of travel. 
2. Home – Icon shows where the vehicle returns to on certain failsafe settings and guidance modes. 
3. Rally – Icon shows a secondary land point for the vehicle, used by failsafes and guidance modes. 
4. Land – Where the vehicle is expected to stop/hit the ground when user puts it into Land Waypoint 

mode. 
5. Takeoff –When a Vertical Take-Off and Landing (VTOL) is launched, it goes to this location after 

reaching the takeoff transition altitude.  
6. Waypoint – A generic waypoint – see Section 5.3.2 Generic Waypoints. 
7. Panorama – A waypoint that the vehicle orbits while taking pictures – see Section 5.4.1 Panoramas. 
8. Area Waypoint – A search pattern that the vehicle flies. See Section 5.4.2 Area Waypoints (AWP). 
9. Gimbal Target – In certain modes, the gimbal points at this location, which users can drag around 

the map with the mouse. 
10. Upload Indicator – When this is blinking, it means the VC and the Kestrel 3 Autopilot are out of 

sync. The user has edited the flight plan and now needs to upload it to the Kestrel 3 by pressing this 
button, so the changes are applied to the Kestrel 3. 

11. Nav Debug – Additional telemetry available from the Kestrel 3 Autopilot. 
12. Gimbal – Current status of the gimbal onboard the vehicle. 
13. Wind – Estimated wind speed and direction, if applicable. 
14. Nav Info – Additional telemetry available from the Kestrel 3 Autopilot. 
15. Detailed Vehicle Health (Spider Display) – Health status of the vehicle and the four speed 

controllers. Shows offsets (deviations from the average) of current, temperature, and thrust for each 
arm. 

16. Map Scale – Current scaling of the map. 
17. Handle for Lower Map Pull-out – Click here to display/hide the lower map pull-out, which gives 

information about the flight plan. 
18. Handle for Right Map Pull-out – Click here to display/hide the right-hand map pull-out, which 

contains overrides, payload controls, etc. Use the View main menu entry to choose what is shown in 
this pull-out. 

19. Hover Here Now – Appears as this symbol:  (not shown in image above). This icon appears on 
the map when the Hover guidance button is pushed. After that, it can be dragged on the map to 
change where the vehicle is hovering. 

Basic Icon Functions 
Following are details about the Map and Flight Plan Display.  
Overlays – Various overlays can be turned on and off using check-boxes in the right-hand map pullout. 
These include: Nav Debug, Gimbal Info, flight control arrows, Wind info, Nav info, the Spider display, 
Agent Info, and the Camera view (flashlight). 
Upload Indicator – Appears (and blinks red) when the user has modified the flight plan and those 
modifications have not been uploaded to the Kestrel 3 Autopilot. Click on this indicator to upload the 
flight plan and get the Kestrel and the VC back in sync. 
Flight Plan – Icons on the map show the positions of the various flight items, including Takeoff, 
Waypoint, Panorama, Area Waypoint, Rally, and Land points. Flight items are added by right-clicking on 
a blank part of the map and selecting Insert Commands.  
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By default, a command is inserted at the end of the flight plan. However, if a flight item is selected 
(blinking blue), then the new item will be inserted into the flight plan after the selected item.  

Multiple waypoints can be quickly added by either clicking the Add Waypoint icon ( ) in the lower 
map pull-out and then clicking on the map, or by holding down the CTRL key while clicking on the map. 
Alternatively, waypoints can be added by right-clicking anywhere on the map and inserting a command. 

Route – A closed cycle of flight items makes up a route. The last item in a route is always a Goto 
command, which tells the UAV which command to jump to in order to restart the route. On the map 
display a route appears as a set of connected waypoints and loiter points that form a loop.  

To Create a Route 
1. Add a series of waypoints and loiter points to the map.  

a. The VC automatically connects these points to form a route.  

2. Upon adding all desired points, right click on the map. 

3. Select Insert Commands->Finish Route.  
a. This causes the VC to add a Goto command after the last route item.  
b. The Goto command causes the UAV to return to the first item in the route and then continue 

executing the route.  

4. Once a route is finished, add a new route by adding flight items to the map.  
a. During flight, the UAV will continue flying its current route until the operator commands it 

to execute a new route. 

Pull-out Icon Functions 
Icon Title Function 

 
Lower Map  

Pull-out 

At bottom of map; displays a representation of 
the current flight plan in table format, with 
numerical representations of important features 
of each flight item. See Section 5.3.1 Flight 
Plan for more information. 

 File grouping For loading and saving flight plans to disk, and 
up/downloading them from the vehicle. 

 Cmd 
Displays the “current” command in the flight 
plan and allows changing the current 
command. 

 
Waypoint 
Window 

Controls payload behavior at the flight 
items/waypoints. 

 Editing Group Assists in editing/placing flight items on the 
map. 

 Order Group 
For changing order of flight items within the 
table, or deleting flight items from the table. 

 

Right-hand Map 
Pull-out 

Contains layers control for displaying different 
resolution maps. Also contains overrides:  
• Enabled override: Allows forcing the 

aircraft to a different Altitude, Airspeed, or 
Heading (VTOL only). 

• Disable override: Kestrel 3 Autopilot 
returns to its current desired altitude, 
airspeed, or heading.  
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5.1.3 Menu Bar 

 
The Menu bar is along the top of the main VC window, to the left of the Indicator Lights. 

• File – Allows the user to load and save the current flight plan to disk, and load and save the aircraft’s 
complete set of settings to disk (as an XML file). 

• View – Allows the user to change displayed units in the VC, add/remove items from the right-hand 
map pull-out, display the Replay Window, and choose what is shown in the Advanced Modes group 
and the Payload Modes group. 

• Agents – Allows the user to select which agent is controlled by the VC. 
• Settings – Shortcuts to the various F5, F6, and F7 settings screens. 
• Command – Another way of changing the current flight mode, in addition to the Flight Mode 

buttons. 
• Help – Gives access to the Help window and shows version information. 

5.1.4 F6 Commbox Screen 
This screen allows the user to set the modem channel when using Microhard modems. See Section 5.2 
Establishing Communications. For 3DR modems, use the APMPlanner2 application to change channels. 
To access this screen, press the F6 key from the VC main screen. For 3DR modems, use the 
APMPlanner2 application to change channels. See Appendix C: 3DR Modem. 

5.1.5 F7 Comm and XML Settings Screen 
The top section of this screen is used to set up comms with the agent. See Section 5.2 Establishing 
Communications for details. The rest of this screen holds default values for many VC functions. For 
example, when a new VTOL waypoint is created, the values for that waypoint come from the Waypoint 
Defaults for Helicopters section of this screen.  

To access this screen, press the F7 key from the VC main screen and select Comm and XML Settings at 
left. 

5.1.6 F7 Map Settings Screen 
This screen allows adding maps to the VC for display on the main map screen and to control which maps 
are displayed. Other controls allow the user to adjust the map screen’s settings. For a description of how 
to create new maps, see Section 5.7 Creating and Loading Maps. 

To access this screen, press the F7 key from the VC main screen and select Map at left. 
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5.2 Establishing Communications 
Several methods exist for using the VC to communicate with a Kestrel 3 Autopilot.  

• The primary method (used for flying) uses the Handcontroller, which communicates with the Kestrel 
3 Autopilot over the air using two Microhard modems. One is installed in the Handcontroller and the 
other is attached to the Kestrel 3 Autopilot. The Handcontroller communicates with the VC (running 
on a PC) via USB cable or WiFi. 

• Another communication method (not used for flying) involves connecting the PC computer directly to 
the Kestrel 3 Autopilot via cable. This method does not require the Handcontroller, but it prevents 
flying, since there is a cable between the PC computer and the Kestrel. 

5.2.1 Communications Over WiFi 
The Handcontroller contains a WiFi access point. PCs equipped with WiFi hardware can connect to this 
access point using the same Windows® controls that connect PCs to WiFi internet access points. Once this 
connection is established, the user can configure the VC to communicate with the Handcontroller over the 
air, rather than via USB cable. 

Global Settings 

 
Step 1.  

 
To set up this configuration, prepare the VC to communicate via WiFi:  

1. In the VC, navigate to the F7 Comm and XML Settings screen. 
a. Use the F7 key to bring up the Global Settings window. 
b. Select Comm and XML Settings in the upper left-hand corner. 

UDP Settings 

 
Steps 2 and 3.  
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2. In the UDP Settings group, check the Enable UDP checkbox. 

3. Configure the UDP settings as depicted. 

NOTE: 

• After making changes in this UDP Settings group, restart the VC for the changes to take effect.  
• When Enable UDP is checked, the VC closes the comport and greys-out the Communications Port 

group. 

WiFi Access 

 
Step 4.  

 
4. Connect the PC computer to the WiFi access point inside the Handcontroller. 

a. Ensure the Handcontroller is turned On. 

5. Open the computer’s wireless network utility and connect to WLAN-AP-HC## (Handcontroller’s 
access point). 

Verify Connection on Main VC Screen 

 
Steps 6 and 7. 

Verify that a connection is made by:  

6. Returning to the VC’s main window. 

7. Confirming that the status window displays a Commbox-HC entry (see the blue arrow in above 
graphic). 
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5.2.2 Comms Over a USB Cable 
The Handcontroller contains hardware that emulates a pair of serial ports. When connected to a PC 
computer (using a USB cable), these serial ports appear in Windows. One of these ports is used to 
communicate with the VC, and the other is used for advanced configuration and development. This 
connection mode requires a cable between the Handcontroller and the PC, but it works with PCs that do 
not have WiFi hardware. 

Setting up the Configuration 
1. Connect the Handcontroller to the computer via USB cable.  

a. Use the USB jack on the Handcontroller (see Section 2 System Overview for photo showing 
location of Handcontroller jacks).  

2. Be sure the Handcontroller is turned on (or the user won’t be able to open the appropriate comport in 
the VC).  

3. Open the VC on the PC computer.  

4. Navigate to the F7 Comm and XML Settings screen (see Section 5.2.1 Communications Over WiFi).  

UDP Settings 

 
Step 1. 

1. At the top of that screen, in UDP Settings group, ensure the Enable UDP checkbox is NOT checked. 

NOTE:  

• If the Enable UDP checkbox was changed, restart the VC for changes to take effect. 

Communications Port (Comport) 

 
Step 1.  

Continuing on the same F7 screen as the previous step: 

1. Open the comport by selecting the correct port in the Port dropdown in the Communications Port 
group. 
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NOTE: 
• If the serial port is available, it automatically opens upon selection from the drop-down list.  
• If the serial port does not open, it is either in use by another program or not functional. 
• When the Handcontroller is attached to the PC computer via USB cable, two comports appear. 

Usually, the correct item is higher numbered.  

COM Indicator 

 
Steps 1 and 2.  

With the comport open, the COM## indicator, bottom left corner of the main screen, is no longer red. 

Verify the connection is working by: 

1. Returning to the VC’s main window. 

2. Seeing that Commbox-HC shows up in the status window (see last image in Section 5.2.1 
Communications Over WiFi). 

NOTE: If the status window says Commbox No Comm, try selecting a different comport on the F7 
screen. The VC will automatically open the last serial port used by default. 

 
 
5.2.3 Using the Kestrel Programming Cable 
This communication method connects the PC computer directly to the Kestrel 3 Autopilot using a cable. 
This method does not use the Handcontroller, and is not valid for flight operations. 

To use this mode of communication, connect the Kestrel to the PC computer as described in Section 3.6.3 
Updating the Firmware, with the following exceptions:  

• Do not connect the Kestrel 3 Autopilot programming cable’s green wire. 
• Plug the Kestrel 3 Autopilot programming cable into the modem port on the Kestrel 3, not the Ser 1 

port. 

NOTE: To configure communications in the VC, use the same method as described in the above section. 
EXCEPTION: The comport should be the same one the Kestrel programming cable is plugged into. Since 
there is no commbox/Handcontroller attached, the status window will say Commbox No Comm. This is 
expected behavior, and not an error. 

 
 
With the correct agent selected in the agent list (see next section), communications should function – 
assuming the port is open and the Kestrel 3 Autopilot is powered up. 
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5.2.4 Selecting an Agent 
For the VC to communicate with a Kestrel 3 Autopilot, that Kestrel needs to be in the list of “active” 
agents above the Artificial Horizon. 

Artificial Horizon 

 
List of Agents above Artificial Horizon. 

To control which agent(s) are in that list: 

1. Press F4, or click the Agents dropdown to open the Edit Agent List. 

 
Edit Agent List Dropdown.  

To make an agent appear in the Active Agents List above the Artificial Horizon: 

2. Check that agent’s checkbox in the On column.  
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Making an Agent Appear in Active Agents List. 

 

NOTES:  

• The serial number (Adr/SN), Kestrel Type, and Vehicle Type must all be correct in order for 
communications to function with that agent. 

• If the user’s vehicle is not listed:  
– Add it to the list by filling in the bottom (blank) row with at least the serial number (Adr/SN), 

Kestrel Type, and Vehicle Type.  
– Then make that vehicle active by checking its On checkbox. 

• If the VC has comms with a Kestrel 3 Autopilot, it appears in the Pinging Agents list. For example, in 
the picture above, the VC currently has comms with a Kestrel 3 Autopilot (serial number 3136), 
which happens to be configured for a helicopter. 

• If no Kestrels appear in the ping list, validate that everything (the vehicle and the Handcontroller, if 
needed) is powered up.  

• Also, check that all needed cables are connected. In some instances, a vehicle reboot helps establish 
communications.  

• To communicate with the Kestrel 3 Autopilot over radio (via Handcontroller), unplug the Kestrel 
programming cable from the Kestrel; its presence can prevent the radio from functioning correctly. 

5.3 Basic Mission Planning 
The Map window, described in Section 5.1.2 Map and Flight Plan Display, in the VC can be used to 
monitor the position and navigational status of the UAV and manage the flight plan. Flight plans are 
made up of zero or more flight items, such as waypoints (of various types), panoramas, loiters, loop 
commands, and perhaps a takeoff and/or rally and land point (depending on the aircraft type).  

The map displays the position of all agents and their flight items. Each agent, and associated set of flight 
items, has a unique color (which the user assigns on the Add Agents window – see Section 5.2.4 Selecting 
an Agent). The information in the flight plan, status, wind, and keyboard control is for the selected agent 
only.  

5.3.1 Flight Plan 
The Flight Plan lists all flight items associated with a particular agent. The flight plan can be viewed in 
list form using the “pull out” control at the bottom of the map window. The following types of commands 
are supported: 
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Zero or one of the following: 

• Takeoff (optional for VTOL) 
• Rally Point (always associated with a Land Point) 
• Land Point (optional for VTOL) 

Zero or more of the following: 

• Waypoint 
• Area Waypoint (a search area) 
• Loiter (Fixed Wing only) 
• Hover (VTOL only) 
• Panorama (VTOL only) 
• Goto/Loop Command 

All commands except the Goto command have an associated altitude and airspeed. These values can be 
changed by double-clicking on the flight item’s icon on the map or by editing the value in the Flight Plan 
window (lower map pull-out).  

To add a command to the flight plan, perform either of the following: 

• Right-click on the Map window and select Insert Commands. 
• Or click in a blank row in the Flight Plan window. 

– Then select a flight item type from the Type dropdown menu. 

Multiple waypoints can be quickly added by either clicking the add waypoint icon ( ) in the lower map 
pull-out and then clicking on the map, or by holding down the CTRL key while clicking on the map.  

Understanding and Creating a Route 
A closed cycle of flight items makes up a route. The last item in a route is always a Goto command, 
which tells the UAV which flight item to jump to in order to restart the route. On the map display, a route 
appears as a set of connected flight items that form a loop.  

To create a route: 

1. Add a series of flight items to the map.  
a. The VC automatically connects these points to form a route.  

2. When all desired points are added, right-click on the map and select Insert Commands->Finish Route.  
a. This causes the VC to add a Goto command after the last route item.  

b. The Goto command will cause the UAV to return to the first item in the route and then 
continue executing the route.  

3. Once a route is finished, a new route can be added by adding flight items to the map.  

During flight, the UAV will continue to fly its current route until the operator commands it to execute a 
new route by right-clicking on an item in the desired route in the Flight Plan window and selecting “Set as 
Current Command,” or by right clicking on the desired item and selecting “Set as current command.” 

Upload Function 
After the flight plan is entered:  

1. Use the Upload button in the Flight Plan Tools. 

2. Or, click the Upload Indicator button on the Map. 
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3. Or, right-click on the map and select Upload Flight. 
a. The flight plan is executed when the Kestrel 3 Autopilot is in Nav Mode.  
b. All flight items (except the loop) have an associated legal position given in latitude and 

longitude.  
c. For user convenience, a separate field for relative waypoint placement is given. This position 

indicates the position of the waypoint relative to home in meters north and east.  

Goto/Loop Items 
A Goto instructs the Kestrel 3 Autopilot to jump to a different flight item in the flight plan. Gotos can be 
edited using the lower map pull-out or by double-clicking on them. In the lower map pull-out, the 
Time/Index column gives the Goto’s destination – flight item number that becomes the next flight item 
when the Goto is encountered while flying the flight plan. 

5.3.2 Generic Waypoints 
A generic waypoint is a location to which the vehicle will fly before it continues to the next flight item in 
the flight plan. To add a generic waypoint to the map:  

1. Right-click on the map. 

2. Choose Insert Commands/Waypoint. 

3. Or left-click on the map with the control key held down.  

 
Parameter Editor – Generic Waypoints. 

To bring up the parameter editor:  

4. Double-click on the waypoint icon on the map.  
a. This brings up the parameter editor, which allows customizing of the waypoint. 
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Primary Waypoint Functions 
Following are the fields of the parameter editor when a waypoint is selected: 

• Spd – Determines aircraft ground speed (airspeed for fixed-wing aircraft) as it approaches the 
waypoint (i.e., while traveling from the previous item in the flight plan to this waypoint). 

• Alt (Height Above Launch) – Aircraft will attempt to reach this altitude by the time it reaches this 
point. If the Kestrel 3 Autopilot does not actually reach this altitude when it reaches this waypoint’s 
lat/long, it just proceeds to the next flight item as if it had reached this altitude.  

• Latitude and Long – Position of the waypoint in degrees latitude and longitude. There are several 
ways to influence this position: 1. Type the desired numbers into these boxes; 2. Type it into the 
waypoint’s line in the lower map pull-out; 3. Drag the waypoint icon on the map; 4. Adjust North and 
East settings. 

• Payload – Button opens a window for specifying details of the camera payload used in this waypoint. 
This window is discussed in further detail in Section 5.4.2 Area Waypoints (AWP), in the subsection 
entitled Payload Popup Window. 

• ^ Alt Rate – Value that dictates rate at which the vehicle will climb/descend in order to reach the 
desired altitude specified above. 

• North and East – Value that determines how far north and east of Home the waypoint is located. 
This is useful if the operator needs to specify the position of the waypoint with respect to the Home 
position. 

• Transit Mode and Transit Heading – Define the heading behavior while approaching this 
waypoint’s position.  
– Hold Prev = Maintain whatever heading the aircraft already had.  
– Fixed = Yaw the aircraft to Transit Heading.  
– Bearing = Immediately yaw the aircraft to point at this waypoint's position.  
– Bearing @ speed = Yaw the aircraft to point at this waypoint's position after reaching a minimum 

speed.  
– Transit heading is ignored if Transit Mode is not set at Fixed. 

• Term Mode and Hover Time – What to do when the aircraft approaches the waypoint's position.  
– Blend = Cut the corners/pre-turn.  
– Pass Through = Pass over the waypoint’s position and then continue to the next flight item w/o 

stopping.  
– Hover = Fly to the waypoint and then hover for Hover Time seconds (zero means hover forever).  
– Hover time is ignored if Term Mode is not Hover. 

• Hover Hdg Mode and Hover Heading – Define the heading behavior while hovering at the 
waypoint. These apply only if Term Mode is Hover:  
– Hold Previous = Maintain whatever heading the aircraft had when it started hovering.  

Fixed = Yaw the aircraft to Hover Heading during the hover. 
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5.3.3 Takeoffs 

 
Parameter Editor – Takeoff. 

 

1. The takeoff point is the location to which the aircraft automatically flies after it is launched.  
a. Depending on how the takeoff point is set up, the aircraft either waits at the takeoff point 

until it is put into a different mode, or it will automatically transition to NAV mode once the 
takeoff point is reached. 

Takeoff Point Menu Functions 
Here are the fields of the parameter editor when a Takeoff Point is selected: 
• Spd: Determines aircraft ground speed (airspeed for fixed-wing aircraft) as it approaches the takeoff 

point. 
• Alt (Height Above Launch): The aircraft will attempt to reach this altitude by the time it reaches this 

point. If the Kestrel 3 Autopilot does not actually reach this altitude when it reaches this lat/long, it 
continues to gain altitude at this location until the specified altitude is reached (if Auto Trans to NAV 
Mode is not selected).  

• Latitude and Long: The position of the takeoff point in degrees latitude, longitude. There are many 
ways to influence this position:  
– Type the desired numbers into these boxes.  
– Type it into the takeoff item’s line in the lower map pull-out.  
– Drag the takeoff’s diamond icon on the map.  
– Adjust the North and East settings. 

• Hov Hdg Mode and Hov Hdg: Defines heading behavior after the aircraft has reached the takeoff 
point and is hovering there.  
– Hold Previous = Maintain whatever heading the aircraft had when it started hovering.  
– Fixed = Yaw the aircraft to Hover Heading during the hover. 

• North and East: The value that determines how far north and east of Home the takeoff point is 
located. This is useful if the operator needs to specify the position of the takeoff with respect to the 
Home position. 

• Climb Hdg Mode and Climb Hdg: Define the heading behavior while the aircraft is climbing to the 
takeoff transition altitude.  
– Hold Prev = Maintain whatever heading the aircraft already had.  
– Fixed = Yaw the aircraft to Climb Heading.  
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– Bearing = Immediately yaw the aircraft to point at the takeoff's position.  
– Climb heading is ignored if Climb Heading Mode is not Fixed. 

• Trans Alt HAL: The altitude above launch when the aircraft will begin moving towards the takeoff 
position. 

• Transit Mode and Transit Hdg: Defines heading behavior while the vehicle is moving to the 
takeoff location.  
– Hold Prev = Maintain whatever heading the aircraft already had.  
– Fixed = Yaw the aircraft to Transit Heading.  
– Bearing = Immediately yaw the aircraft to point at this waypoint's position.  
– Bearing @ speed = Yaw the aircraft to point at this waypoint's position after reaching a minimum 

speed.   
– Transit heading is ignored if Transit Mode is not Fixed. 

• ^ Alt Rate: This value dictates the rate at which the vehicle will climb during takeoff. 
• Auto Trans to NAV Mode: Put a checkmark here to have the aircraft switch from Takeoff mode to 

Navigation mode as soon as the takeoff point and takeoff altitude are reached.  
– If the takeoff point is reached before the altitude, the aircraft will hover at the takeoff point until 

the altitude is achieved. Then it will switch to Navigation mode.   
– No checkmark means the aircraft hovers indefinitely at the takeoff point – until the user changes 

to Navigation mode or some other mode. 
• Payload: This button opens a window for specifying details of the camera payload used in this 

waypoint. This window is described in Section 5.4.2 Area Waypoints (AWP), in subsection entitled 
Payload Popup Window. 

5.3.4 Rally/Landings 
The landing point indicates where the aircraft will land when put into Land Waypoint mode, or when a 
failsafe that sends the aircraft to the landing point is triggered. The rally point acts as an alternative 
landing point, which can be used by the various failsafes.  

Putting the aircraft into Land Waypoint mode sends it to the land point and altitude. When the vehicle 
arrives at that point, it descends straight down to the ground and turns off the motors. Putting the vehicle 
into Land Now mode, on the other hand, makes it land at its current location – it stops moving 
horizontally and descends straight to the ground at its current location. 

 
Parameter Editor – Landing Point.  
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The above figure shows Landing Point settings. Following are descriptions of the elements in this 
window, as used by Land Waypoint mode. 

• Speed: Determines aircraft ground speed (airspeed for fixed-wing aircraft) as it approaches the land 
point. 

• Alt HAL: Altitude to which the vehicle will ascend/descend to, while approaching the land point. See 
next subsection, Altitude Behavior of the Land Point, for more details on the altitude behavior of the 
land point. 

• Latitude and Long: The position of the landing point in degrees latitude, longitude. The following 
options exist to influence this position:  
– Type the desired numbers into these boxes.  
– Type the desired numbers into the landing’s line in the lower map pull-out.  
– Drag the landing’s X icon on the map.  
– Adjust the North and East settings. 

• Transit Mode and Transit Hdg: Define the heading behavior while approaching the landing point’s 
position.  
– Hold Prev = Maintain whatever heading the aircraft already had.  
– Fixed = Yaw the aircraft to Transit Heading.  
– Bearing = Immediately yaw the aircraft to point at the land point’s position.  
– Bearing @ speed = Yaw the aircraft to point at the land point’s position after reaching a 

minimum speed.  
– Transit heading is ignored if Transit Mode is not Fixed. 

• North and East: The value that determines how far north and east of Home the land point is located; 
useful if the operator needs to specify the position of the landing with respect to the Home position. 

• Descent Mode and Descent Hdg: Defines the heading behavior while descending at the landing 
point. Mode:  
– Hold Previous = maintain whatever heading the aircraft currently has.  
– Fixed = Yaw the aircraft to Descent Heading during the descent. 

• ^ Alt Rate: Value that dictates the rate at which the vehicle will descend. 
• Payload: Button opens a window for specifying details of the camera payload used in this waypoint. 

This window is discussed in Section 5.4.2 Area Waypoints (AWP), in subsection entitled Payload 
Popup Window. 

Altitude Behavior of the Land Point – Aircraft is Higher than the Land Altitude 
If the aircraft’s altitude is higher than the land point’s altitude setting (Alt) when the user puts the Kestrel 
3 Autopilot into Land Waypoint mode, the Kestrel will try to descend at a rate putting it at Alt just as it 
arrives at the land point’s position.  

To do this, the Kestrel 3 Autopilot computes the vertical and horizontal difference between its current 
location/altitude and the land point’s location/Alt, and computes a descent rate with the vehicle arriving at 
Alt at the same time it arrives at the landing point’s position.  

• If this computed descent rate exceeds the maximum allowed descent rate, then the maximum allowed 
descent rate is used.  

• This means the aircraft is still too high when it arrives at the land point’s position (it will still be 
higher than Alt). Therefore, the aircraft will continue descending at maximum allowed descent rate 
until Alt is reached.  

• At this point, the descent continues, but at the land point’s ^ Alt Rate – until the aircraft touches the 
ground and turns off its motors. 
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Altitude Behavior of the Land Point – Aircraft is Lower than the Land Altitude 
If the aircraft’s altitude is lower than the land point’s altitude setting (Alt) when the user puts the Kestrel 
3 Autopilot into Land Waypoint mode, the Kestrel will climb at the maximum allowed climb rate while 
moving toward the land point until it achieves Alt. Then it will fly to the land point’s position while 
maintaining Alt.  

When the land point’s position is reached, the aircraft descends at the land point’s ^ Alt Rate, until the 
aircraft touches the ground and turns off its motors. 

 
Parameter Editor – Rally Point. 

Following are rally point settings, used when a failsafe triggers that performs a Rally Land. 

• Speed: Determines the aircraft ground speed (airspeed for fixed-wing aircraft) as it approaches the 
rally point. 

• Payload: Button opens a window for specifying details of the camera payload used in this waypoint. 
This window is discussed in Section 5.4.2 Area Waypoints (AWP), in subsection entitled Payload 
Popup Window. 

• Latitude and Long: Position of the rally point in degrees latitude, longitude. Several methods exist 
to influence this position.  
– Type the desired numbers into these boxes.  
– Type these numbers into the rally point’s line in the lower map pull-out.  
– Drag the rally’s diamond icon on the map.  
– Adjust the North and East settings. 

• Transit Mode and Transit Hdg: Defines the heading behavior while approaching the rally point’s 
position. Mode: 
– Hold Prev = Maintain whatever heading the aircraft already had.  
– Fixed = Yaw the aircraft to Transit Heading.  
– Bearing = Immediately yaw the aircraft to point at the rally point’s position.  
– Bearing @ speed = Yaw the aircraft to point at the rally point’s position after reaching a 

minimum speed.  
– Transit heading is ignored if Transit Mode is not Fixed. 

• North and East: Value that determines how far north and east of Home the rally point is located; 
useful if the operator needs to specify the position of the rally with respect to the Home position. 

• Hover Mode and Hover Hdg: Defines the heading behavior while hovering at the rally point. Mode:  
– Hold Previous = Maintain whatever heading the aircraft currently has.  
– Fixed = Yaw the aircraft to Hover Heading during the hover. 
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5.4 Advanced Mission Planning 
5.4.1 Panoramas 
A panorama is a special waypoint in which the VTOL aircraft circles a lat/long position while taking 
pictures. The position of the panorama on the map is defined as the center of this circle. 

The entry and exit points of the circle control how much of the circle/arc is actually flown, and are 
controlled/set by the flight items immediately before and immediately after the panorama. 

The following images show how the flight items before and after the panorama affect the entry and exit 
points. 

Understanding Panoramas 

 

Panorama Image 
In this image, the vehicle first flies to Waypoint 1 (highlighted green), then flies to 
the arc. Then it flies about 300 degrees of the panorama’s arc in a clockwise 
direction (indicated by the arrow at the 7:00 position), and then exits the 
panorama’s circle and flies to Waypoint 3. 
 

 

Changing Entry Point 
In the same panorama, Waypoint 1 has been moved from the 7:00 position to the 
1:00 position. Note how this affects the panorama – only 90 degrees of the arc 
gets flown (still in the clockwise direction). 

 

Changing Direction 
By changing the panorama’s flight direction from clockwise to counterclockwise, 
the vehicle flies 270 degrees, instead of 90, in the other direction. Note that only 
flight direction was changed. 

 

Complete Circle 
To fly a complete circle, bring the entry and exit waypoints (#1 and #3 in this 
example) within 5 degrees or so of each other, and the panorama will snap to a 
complete circle. 

 

Position of Entry and Exit Waypoints 
Note that the distance between the panorama’s center point and the entry and 
exit points does not matter – it’s the angle between the entry and exit points that 
matters. The entry and exit waypoints can be inside the circle if desired.  
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NOTE: One way to learn how entry and exit points affect panoramas is to create the three flight items as 
shown in the figures above, and then drag them around on the map screen in the VC. Seeing how the three 
flight items interact in real-time allows the user to quickly grasp how they interact. 

Fine-tuning Panoramas 
Panoramas have numerous parameters, which can be accessed by double-clicking on the waypoint icon in 
the center of the panorama. This action brings up the parameter editor, allowing the panorama to be 
customized. 

Panorama Editor  
Following are functions from the Panorama 
Editor (as indicated in the figure). 

• Circle Spd: Determines aircraft ground 
speed (airspeed for fixed-wing aircraft) as it 
flies around the circle/arc. 

• Alt HAL: The aircraft will attempt to reach 
this altitude by the time it reaches the arc. 
Then it will fly the arc at that altitude. If the 
Kestrel 3 Autopilot does not actually reach 
this altitude when it reaches the circle/arc, 
proceeds to fly the arc as if it had reached 
this altitude.  

• Latitude and Long: The position of the 
center of the circle/arc in degrees latitude, 
longitude. Several methods exist to 
influence this position:  
- Type the desired numbers into these 

boxes. 
- Type the numbers into the panorama’s 

line in the lower map pull-out. 
- Drag the panorama’s waypoint icon on the map. 
- Adjust the North and East settings. 

• Radius: Radius of the circle/arc in meters. 
• ^ Alt Rate: Value dictates the rate at which the vehicle will climb/descend in order to reach the 

desired altitude specified above. 
• North and East: Value that determines how far north and east of Home the center of the panorama is 

located. This is useful if the operator needs to specify the position with respect to the Home position. 
• Payload: Button opens a window for specifying details of the camera payload used in this waypoint. 

This window is discussed in further detail in Section 5.4.2 Area Waypoints (AWP), in the subsection 
entitled Payload Popup Window. 

• Pause Time: How long to pause at each photo point before moving to the next. Zero means “come to 
a stop and then immediately proceed to the next photo point.” 

• Circle Hdg and Circle Hdg Mode: Defines the heading behavior while flying the circle/arc. Mode:  
– Fixed = Yaw the aircraft to Circle Heading while flying the circle/arc.  
– Target Center = Yaw the aircraft so it’s always pointed at the center while flying the circle/arc.  

• Transit Mode: Define the heading behavior while approaching the circle/arc.  
– Hold Prev = Maintain whatever heading the aircraft already had.  
– Fixed = Yaw the aircraft to Transit Heading.  
– Bearing = Immediately yaw the aircraft to point at the center of the arc. 

 
Panorama Editor. 
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– Bearing @ speed = Yaw the aircraft to point at the center of the arc after reaching a minimum 
speed. 

– Transit heading is ignored if Transit Mode is not Fixed. 
• Num Pictures: Denotes how many pictures should be taken while flying the circle/arc. The photo 

points (locations where each picture is taken) are shown as the long tick marks in the pictures above. 
• Offset from Entry Point: Denotes how many degrees of arc should be flown before the first photo is 

taken. Default is zero, which means the first photo is taken as soon as the aircraft reaches the 
circle/arc. 

• Approach Spd: Determines aircraft ground speed (airspeed for fixed-wing aircraft) as it approaches 
the circle/arc. 

• Direction: Denotes which way to fly the circle/arc – clockwise or counterclockwise. 
• Gimbal Angle and Target Alt HAL and Tilt/Elevation Angle: These two items control the 

gimbal’s tilt/elevation. Gimbal Angle:  
– Fixed Tilt = Gimbal tilt should always be Tilt Angle.  
– Target Center = Gimbal angle should always be such that the center pixel of the picture is at the 

point in space defined by Latitude, Longitude, Target Altitude.  

5.4.2 Area Waypoints (AWP) 
AWP is a special waypoint type for the Kestrel 3 Autopilot that enables systematic and predictable aerial 
photogrammetry over large geographical areas with minimal operator input. This is accomplished by 
combining up to one thousand sub-waypoints, or photopoints, into a specific pattern, as shown in the 
AreaWaypoint figure.  

 
AreaWaypoint (AWP). Example covers 35 acres (~140,000 sq. meters) with 110 photopoints. Shown are 
the Takeoff (T) and Landing (L) waypoints which, when combined with the AWP, comprise an example of 
a complete Kestrel 3 Autopilot flight plan. 
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As an aircraft traverses an AWP, a photograph event is triggered at each photopoint and all relevant 
details (e.g., aircraft location, altitude and pose) are recorded by the VC at the time of the snapshot. 
The details for each photograph are saved in separate log files, called Event Logs, so they can easily be 
matched with the associated photograph on the camera’s SD card after the flight. This process is 
described in the Matching Images portion of this section. 

Customizing the AWP 
Each AWP can be tailored in many ways to fit specific 
operator needs. The figure shows the configuration 
screen for an AWP, including the following settings: 

Approach Spd: Determines aircraft ground speed 
(airspeed for fixed-wing aircraft) as it approaches the 
AWP (i.e., while traveling from the previous item in the 
flight plan to the AWP). 

Altitude HAL: This altitude will be reached before the 
AWP is traversed, hence all photographs will be taken 
from this altitude. (If necessary, VTOLs will hover at 
the first photo point until the altitude is achieved. Fixed-
wing aircraft will circle outside the search pattern until 
the altitude is achieved). Several factors should be 
considered when choosing an altitude, in particular for 
fixed-wing aircraft, including: 

• Photo Resolution: Higher altitudes cover more 
ground, but photo resolution suffers. Lower altitudes 
provide better resolution but require more photos to 
be taken, thus reducing the achievable coverage area 
in a single flight.  

• Camera Cycle Time: Higher altitudes result in 
photopoints that are spaced farther apart, while lower altitudes result in photopoints that are closer 
together. This particularly affects fixed-wing aircraft where hovering is not possible since the distance 
between photopoints divided by the required airspeed must be greater than the camera’s cycle time 
(min time between consecutive photos). 

Latitude and Long: Two methods exist to influence the latitude and longitude of the center of the AWP:  

• Type the desired latitude/longitude into this box.  
• Click and drag the waypoint icon in the center of the AWP in the VC’s Map screen. 

Payload: Button opens a page for specifying details of the camera payload used in this AWP. This 
window is discussed in Section 5.4.2 Area Waypoints (AWP), in subsection entitled Payload Popup 
Window. 

Alt Rate: Value dictates the rate at which the vehicle will climb/descend in order to reach the desired 
altitude specified above. 

North: Value that determines how far north of Home the center of the AWP is located; useful if the 
operator needs to specify the center of the AWP with respect to the Home position. 

East: Value that determines how far east of Home the center of the AWP is located. This is useful if the 
operator needs to specify the center of the AWP with respect to the Home position. 

 

Configurable AWP Settings. These enable tailoring 
to suit specific operator needs.  
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Speed: Determines speed of the aircraft while traversing the AWP. For fixed-wing aircraft, this is 
airspeed, otherwise this is ground speed. 

Dwell Time: Determines how long the aircraft stops at each photopoint. For clearer pictures, it may be 
necessary to stop and settle (hover) before a photo is taken, this value dictates how long the aircraft will 
hover at the photopoint before snapping the picture and moving on. This value is ignored for fixed-wing 
aircraft.   

Width and Length: Two methods exist for specifying the width of the AWP: 

– Type an exact value here.  
– Click and drag any corner of the AWP (only when the AWP is selected – i.e., its center waypoint 

icon is blinking) to change both width and length. 

Box Angle: By default, the AWP is oriented north-south. Two methods exist for specifying the 
orientation of the AWP.  

– Specify any orientation in this box (-360° to 360°).  
– Click and drag the yellow rotate-handle at the top center of the AWP to align the AWP to any 

orientation (e.g., to align with map features). 

Min Overlap: Value determines the percentage of overlap between neighboring pictures. The value typed 
here can range from 75% overlap to a negative 1,200% overlap, in intervals of 5%. A positive overlap 
means that images from neighboring photopoints will overlap each other by the specified amount. This is 
particularly helpful if the images will later be stitched together using third-party software. A negative 
overlap value means the photopoints are spaced farther apart from each other, leaving unphotographed 
areas in between. This is particularly helpful for very large areas to be sample-photographed with evenly 
spaced photos.  

Wind From Hdg and Wind Spd: The Kestrel 3 Autopilot estimates wind onboard, so this field is 
optional and not often used. However, the operator can override the Kestrel 3 wind estimate by providing 
specific values here. Since the actual flight path of fixed-wing aircraft can vary substantially based on the 
wind speed and direction, these settings allow the user to see how the flight path is affected by various 
wind conditions. 

Roll/Pitch/Yaw Stabilization: Checkboxes enable gimbal-based, active image stabilization if the camera 
is mounted to a gimbal capable of such stabilization. Otherwise, these are ignored. 

L-R Scan: Checkbox allows the operator to change the direction of AWP traversal from Up-Down 
(default) to Left-Right.  

Estimated Time: Provides an estimate of how long it will take to traverse the AWP. When comparing 
against available flight time on a specific aircraft, this number should be combined with times required to 
takeoff, navigate to the AWP, and navigate back to the landing location when finished. Note that this 
functionality is only accurate for VTOL aircraft at this time and does not take into account the standoff 
and turnaround time required for fixed-wing aircraft. 
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Generating/Saving an Area Waypoint (AWP) 
To generate a meaningful AWP, the following 
conditions should apply: 

1. The VC should be communicating with the 
Vehicle that will ultimately be flying the AWP. 

2. The vehicle’s camera(s) should be configured 
properly (see Section 5.5 Configuring Camera 
Payloads). 

3. A base map of the desired area should be loaded 
into VC (see Section 5.7 Creating and Loading 
Maps). 

With these conditions met, the operator can right-
click on the map and choose Insert Commands-
>Area Waypoint, as seen in the figure, which will 
create a default-configured AWP centered at the click. Manipulating and/or configuring the AWP for 
specific needs can be accomplished by interacting with one of the following items: 

• AWP: Clicking and dragging the AWP’s center waypoint icon will move the AWP on the map. 
Double-clicking the center waypoint icon will bring up the configuration screen, as shown in the 
above figure and described in this section. 

• Any corner of the AWP’s yellow translucent box: Clicking and dragging a corner of the AWP will re-
size the AWP. 

• The small, yellow rotate-handle at the top-center: Clicking and dragging this handle will rotate the 
AWP about the center waypoint icon. 

For a detailed discussion of all variables related to the AWP, see Section 5.4.2 Area Waypoints (AWP), 
subsection Customizing the Area Waypoint. 

The operator can save any AWP, as part of a flight plan, for future use. Since an AWP is considered a 
Flight Item, just as a standard waypoint or a loiter point, it can be saved as part of a flight plan just as any 
other flight item offered in the VC, by selecting File->Save Flight Plan from the VC. 

Payload Popup Window 
This figure shows the Payload Popup window as it 
appears when the operator clicks the Payload button 
from the AWP configuration screen.  

From this window, the operator can copy the camera 
settings from an installed camera or enter custom 
settings. To copy from an installed camera, select the 
camera from the dropdown menu at the bottom of the 
window and click Copy. This brings all the necessary 
settings from this camera in the F5->Gimbal-
>Section Cameras into the AWP.  

  

 
Generating an AWP from the VC. 

Payload Popup Window for Specifying 
Camera Payload Details. 
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Each value in the table can also be manually overwritten. Note that for cameras that zoom in and out, it is 
important for the HFOV item to match the camera’s current zoom amount before the AWP is flown. 
Otherwise, the desired picture overlap will not be achieved. (In order for the Kestrel 3 Autopilot to know 
how closely-spaced the pictures should be, it needs to know how zoomed in/out the camera is.) If the 
operator would also like to activate a servo at each photopoint in the AWP, the Actuate Waypoint Servo 1 
checkbox can be checked. Proper functionality of this feature requires that a servo be properly configured 
as a waypoint servo. See Section 5.5 Configuring Camera Payloads for an explanation of what the various 
fields mean.   

Matching Images with Data 
The images taken while traversing an AWP are saved on the 
camera’s SD card. Each of these images are later to be matched 
to an Event Log data file automatically saved by the VC (see 
next subsection, Matching Process, Step 2). To make the post-
flight matching process easier, during pre-flight the operator 
should tell the VC the number that the camera will assign to the 
next picture it takes.   

To do this, the operator can power up the camera and take a 
picture manually (i.e., press the shutter release) and note what 
file name the camera assigns to the picture on the SD card. For 
example, assuming the picture just taken is called 
IMG_0307.JPG, assume the next picture taken is number 308.  

The operator would then enter 308 into the Next Picture Number 
field of the Payload Settings box, as shown in the figure. If this 
box is not present, select View->Payload Settings. This 
information will be uploaded to the Kestrel 3 Autopilot and the 
data recorded by the VC corresponding to the next photo will be 
recorded as Event 308. 

As mentioned, the VC produces an Event file (e.g., Event_####.xml) for each picture taken as part of an 
AWP. As long as VC’s Next Picture Number field is synchronized with the camera, the number in the 
name of each Event file will match the number the camera assigns to the photograph.   

Begin the process of matching the camera’s images with the VC’s Event files by opening the Image 
Matcher page in VC (F7->Image Matcher, or Settings->Image Matcher), as shown in the figure below. 

Next Picture Number. Can be set in 
the Payload Settings box of the right-
hand pullout of VC. If this box is not 
present, select View->Payload 
Settings. 
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Image Matcher. Aligns images with their corresponding event data. 

Matching Process 
The following steps are a guide for working through the matching process: 
1. Select the Picture Directory in which the images are located.  

a. Typically the SD card from the camera plugged into the computer. 
b. Some operators occasionally import images to a new directory on their computer. 
c. This will populate the left-hand side of the table with data about all the images in the 

specified directory (as shown in the figure above). 

2. Select the Event Directory in which the event logs are located. 
a. The VC creates a folder for all events created by a Kestrel 3 Autopilot during a complete 

power cycle (e.g., from the time the Kestrel is powered on to the time it is powered off).  
b. For typical installations, these folders reside in this location: C:\Program Files (x86)\Procerus 

Technologies\VC 2.5H\Event Logs\ 
c. Select the folder containing events by matching the ID of the Kestrel 3 Autopilot, or by the 

Date Modified field of the folders in this directory. 

3. Press the Copy Events into the Table button.  
a. This will populate the right-hand side of the table with data about all of the events in the 

specified directory.  The table should now appear as shown in the figure below, with both 
Images and Events loaded into the table. 
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Images and Events Loaded into Table. Items are ready for alignment, if necessary. Alignment is 
done when all image numbers match with photo numbers (red circles). 

4. If the only events in the folder are those belonging to the AWP, and the only images in the folder are 
those belonging to the AWP, then no alignment is necessary.  

5. Press the Check All button to select all images for processing.  
a. However, if additional images/events are present, or if any are missing, use the  buttons 

to move images and/or events up/down so the image numbers match photo numbers (e.g., 
Image IMGP_0044.jpg and Photo Num 44 as highlighted red). 

b. Note that if the Next Picture Number procedure in the Matching Images with Data Section 
(above) was not followed before the AWP was flown, matching the images with the events 
will be more difficult.  Viewing the images in an image viewer, and comparing the image file 
date/times with the event file data/times, can help. 

6. Select all paired Images/Events using the Check All button or by selecting each row (matched 
Image/Event) that will be used. 

7. Press Decorate Selected Images with EXIF Data to write relevant metadata to the images. 

8. Further data can be exported into Google Earth *.kml format or a Pioneering log file. For Google 
Earth, press the  button. For a log file in Pioneering format, press the Dump Selected Events to 
Pioneering Log File button. Exporting to Google Earth format is useful, because the resulting *.kml 
file (and associated images) can be loaded into Google Earth, and alignment with the existing terrain 
checked. This helps the user verify the images and the event records were properly matched. 
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5.5 Configuring Camera Payloads 
As cameras and gimbals are often used together, a new section was added to the F5->Gimbal screen for 
configuring camera payloads. This section is outlined red in the following figure.   

 
Gimbal/Camera Configuration Screen. F5->Gimbal. 

 
Several Procerus-supported cameras are pre-configured:  

• Pentax Optio W90 
• Sony Lanc 
• Sony FCB-IX11A 
• Procerus Vision Processing Unit (VPU) imager 
• SEI camera  

In addition, four user-definable cameras are listed and can be triggered either by General Purpose 
Input/Output (GPIO) pins or by a pulse width modulation servo signal (Servo).  

In addition, a Procerus video mux chip can be installed/configured to stream video through the video 
transmitter from up to four sources using two GPIO pins.  
The camera configuration section is based on the notions of installed and active cameras. A camera is 
installed if it is physically connected to the Kestrel 3 Autopilot and its Installed checkbox is checked (see 
figures in Mux Settings section below for examples of the Installed checkbox).  

A camera is active if it is selected via the Camera button in the Payload Modes section of the VC, as 
highlighted red in the figure below.   
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Selecting the Active Camera 
Pressing the Camera button (figure below) cycles through the installed cameras and makes the camera 
whose title appears below that button the current, active camera. In the figure, Pentax shows as the active 
camera.   

 
Selecting the Active Camera. 

A camera can be automatically selected as the active camera on bootup if it is installed and the Selected 
on Bootup checkbox is checked (see figures in next sections for examples of the Selected on Bootup 
checkbox).  

The Camera button is made visible in the VC through View->Customize Advanced/Payload Buttons and 
choosing Camera as a Selected Function. 

5.5.1 Mux Settings 
To configure the video mux, the user must know which pins (i.e., GPIO pins from the Kestrel 3 
Autopilot) are physically connected to it. This is typically determined using the wire colors in conjunction 
with the Kestrel 3 Wiring Guide.  

Once the pin numbers are determined, configuring the mux is a simple process of selecting the one or two 
pins from the dropdown menus beside Mux IO Pin 1 and Mux IO Pin 2, respectively, as shown in the 
figure below.   

 
Mux Settings. 

Note that it is OK to configure only Pin 1 when switching between the outputs of only two cameras. 
However, both pins must be configured when switching between three or four cameras. The video output 
of any installed camera can be connected to a channel on the mux chip itself.  

The user will need to let the autopilot know to which channel each camera is connected (see figures in 
next section). When properly configured, the mux chip passes through the video stream of the active 
camera.  
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5.5.2 General Camera Configuration 
If the Installed checkbox is checked (e.g., in the figure Pentax Configuration below), the camera becomes 
visible to the Kestrel 3 Autopilot and is, therefore, eligible for selection as the active camera.  

• When both Installed and Selected on Bootup checkboxes are checked, the camera automatically 
becomes the active camera when the Kestrel 3 Autopilot is booted.   

• The Gimballed checkbox lets the Kestrel 3 Autopilot know if the camera can be rotated for targeting 
and stabilization.  

• The VPU Inline checkbox lets the Kestrel 3 Autopilot know if the additional functionality offered by 
the VPU can be used in conjunction with this camera.  

• The Mux Channel is a dropdown menu allowing the user to specify which channel of the mux chip (if 
installed) the camera video output is connected to.  

• The remaining options are camera-specific and are described in the following sections. 

5.5.3 Pentax Configuration 
The Pentax Optio W90 is pre-configured in terms of camera properties such as aspect ratio and field of 
view. However, in addition to these properties and general checkboxes discussed previously, the user 
needs to let the Kestrel 3 Autopilot know the following:  

• Which digital IO pin the Pentax is connected to (i.e., DIO Pin 36 shown in figure below). 
• Azimuth and elevation angles at which it is nominally mounted (e.g., when it is not mounted on a 

gimbal, or when the gimbal itself has zero elevation and zero azimuth). 

 
Pentax Configuration. 

5.5.4 LANC Configuration 
As LANC is a communication protocol, this camera represents the LANC family of cameras. As a result, 
more settings are available to the user for configuration. The operator should choose the Mux Channel 
and Serial Channel, shown in the figure below, according to how the camera is physically connected to 
the Kestrel 3 Autopilot.  

 
LANC Configuration.  
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Choose the camera settings such as aspect ratio, field of view, shutter delay, cycle time, and mount angles 
according to specifications of the LANC camera chosen.  

• Shutter Delay represents the time (in seconds) between a snapshot command and actual snapshot, and 
can vary greatly between cameras and camera trigger mechanisms.  

• Cycle Time represents the minimum time required (in seconds) between consecutive snapshots. 

5.5.5 Sony FCB-1X11A 
The Sony FCB-IX11A is pre-configured in terms of camera properties such as aspect ratio and field of 
view. However, in addition to these and the general checkboxes discussed above, the user must inform the 
Kestrel 3 Autopilot of the following:  

• Which Serial Channel the FCB is connected to (e.g., Payload Serial B as shown in figure below). 
• Azimuth and elevation angles at which it is nominally mounted.  

 
SONY FCB-1X11A.  

The FCB can be further controlled using the Camera Settings in the right-hand pullout of the VC, which 
enables Focus, Exposure, Gain, Iris, Shutter speed, and Zoom control.  

Select View->Camera Settings in the VC to enable the appearance of these settings in the right-hand 
pullout. 

5.5.6 VPU Imager 
The Procerus VPU Imager is pre-configured in terms of camera properties such as aspect ratio, field of 
view, shutter delay, and the required cycle time between successive photos and that a VPU is inline. 
However, in addition to these and the general checkboxes discussed above, the user will need to let the 
Kestrel 3 Autopilot know which Serial Channel the VPU is connected to (e.g., Payload Serial A in the 
following figure) and azimuth and elevation angles at which it is nominally mounted (e.g., when it is not 
mounted on a gimbal, or when the gimbal itself has zero elevation and zero azimuth). 

 
VPU Imager.  
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5.5.7 GPIO Cameras 
A GPIO camera is any off-the-shelf camera that can be triggered using a general purpose input/output pin 
on the Kestrel 3 Autopilot. Many such triggers exist and can be purchased independently or through 
Procerus. The figure below shows the primary settings to configure.  

 
COTS Camera Triggered Using a GPIO Pin.  

The Pulse High checkbox determines polarity of the trigger pulse (signal idles low and pulses high when 
box is checked, reverse when unchecked). The Shutter DIO Pin specifies which GPIO pin the camera is 
connected to, and the Shutter Pulse (ms) determines how long (in milliseconds) the shutter pulse is to be 
held high/low before the signal returns to nominal polarity/idles again.  

In addition, the camera properties such as aspect ratio, field of view, shutter delay, and required cycle 
time between successive photos need specifying along with nominal camera mount angles. 

5.5.8 Servo Cameras 
A servo camera is any off-the-shelf camera that can be triggered using a pulse width modulated servo 
input signal. Many such cameras triggers exist and can be purchased independently or through Procerus. 
The figure below shows the primary settings the user needs to configure.  

 
COTS Camera Triggered Using a  
Pulse-width-modulated Servo Input Signal. 
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The Shutter/Record Pin dropdown specifies which servo line the camera is connected to. The Shutter 
PWM (uS) is an integer in microseconds, which determines the timing/shape of the servo signal for 
triggering the shutter (should be an integer between 1000-2000). Similarly, Record PWM (uS), Zoom In 
PWM (uS), and Zoom Out PWM (uS) determine the timing/shape of the servo signal for toggling the 
record functionality, zooming in, and zooming out, respectively.  

Each of these PWM values should be an integer between 1000 and 2000. In addition, camera properties 
such as aspect ratio, field of view, shutter delay, and required cycle time between successive photos needs 
to be specified, along with nominal camera mount angles. 
5.5.9 SEI Agriculture Camera 
The SEI Agriculture camera involves multiple cameras interfaced via the SEI payload control board, 
which is triggered and driven by the Kestrel 3 Autopilot using serial messages. Primary camera settings 
are displayed in the image below. Note that the gimbal pause time indicates the time the operator desires 
the payload gimbal to be stationary before pictures are taken. 

 
SEI Agriculture Camera. 

The SEI camera can be operated using the Agriculture Camera Control 
window. This is opened by pressing CTLR + SHIFT + C on the keyboard 
(image below) or by pressing the SEI Camera Window button in the lower 
right-hand corner of the Map display (image at right).   

Note that the SEI Camera Window button does not appear unless the SEI 
camera is marked as “installed” (via the Installed check box in the SEI Agriculture Camera image above). 

In the Agriculture Camera Control window (image below), the operator can start/stop sessions and 
monitor payload status. 
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SEI Agriculture Camera Control Window. 

5.6 Data Log Recovery/Review 
The Indago system can be configured to store data log files, which contain recordings of Kestrel 3 
Autopilot telemetry, in various locations. These data log files can later be replayed by the VC, allowing 
the user to precisely analyze a flight. These log files are a critically important debugging tool that is 
crucial to data analysis when something goes wrong. They allow the user to replay the flight step-by-step, 
which is often the only way the cause of serious issues (such as crashes) can be identified. 

Onboard the Kestrel 3 Autopilot 
The back of the Kestrel 3 Autopilot contains a Micro SD slot. If a Micro SD card is inserted, telemetry 
log files are written to the card until it is full. 

The operator can use the SD Card group on the VC’s F5 Nav Filter setup screen to see if this logging is 
taking place. 

 
SD Card Group.  

If the Black Box State is Logging, the telemetry file is being written. If it’s Idle, the telemetry file is not 
being written. This is usually caused by no SD Card being present, or the inserted SD Card being full. 

• Telemetry files on the SD card have file names in this format: BB_657_382403.m.  
• The first number (657 in this example) is the boot number.  

– Each time the Kestrel 3 Autopilot is powered up, the boot number increases by one.  
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• This makes it easy to know the order in which the files are created – simply sort the files in order of 
increasing boot number.  

• These files can be loaded into the VC’s replay system as discussed later on in this document (see the 
subsection that follows, Reviewing/Replaying a Data Log File). 

Note that in extreme situations (such as crashes), the last file on the SD card might be incomplete. The 
nature of flash memory is such that data writes are time consuming. Thus, if power to the Kestrel 3 
Autopilot is suddenly interrupted, the last few records might not be written to the SD card. This is one 
reason the other logging method “In the VC” is so valuable. 

In the VC 
By default, the VC saves a telemetry log file for each of the agents in the active agent list (above the 
Artificial Horizon). In order for these files to contain any data, the VC must have communications with 
those agents (see Section 5.2 Establishing Communications). 

The bottom section of the F5 Datalog screen has controls for starting and stopping the automatic 
telemetry logger in the VC. 

 
Bottom of F5 Datalog Screen. 

Each time a record is stored in this file, the reported numbers of samples (red rectangle in the figure 
above) increases by one. So, if the number of samples is increasing, the user knows the data log is running 
and the VC has communications with that agent. The Start and Stop buttons can be used to start and stop 
the telemetry logging. This capability is handy in situations where the user wants to create one log file per 
flight, etc. 

Two formats can be used for the automatic telemetry log stored by the VC – m or XLS.  

• The first produces a MatLab-format text file, which can be replayed by the VC.  
• The second produces an XML file that can be loaded into various web browsers and spreadsheets but 

not replayed by the VC. It is recommended that the ‘m’ format be used, so the file can be replayed. 

Though the VC can be configured to not log this data, it is highly recommended that the VC be 
configured to generate the automatic telemetry logs. If they are not generated, then debugging any 
problem that occurs is very difficult. Even if an SD card is installed in the Kestrel 3 Autopilot, with 
adequate free space, it is still recommended that the VC be left configured to store its own data logs for a 
measure of redundancy. 

Defaults for automatic telemetry logging are found on the F7 Comm and XML Settings screen, under the 
Telemetry Logger Settings section.  

NOTE: By default, the VC stores the data logs in Datalogs folder, in the folder the VC was installed into: 

• Typically the location is – C:\Program Files (x86)\Procerus Technologies\VC 2.5H\Datalogs 

Reviewing/Replaying a Data Log File 
The VC Replay window allows the user to watch a previously recorded flight. The VC treats the replayed 
data log as if it were an actual flight, so all warnings and failsafe triggers that occur in the replay data log 
will appear during play back as well. 
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When a replay file is loaded, a replay agent is added to the active agent list above the Artificial Horizon. 
Also, all open comports and connections are closed. This guarantees no interference between the replay 
agent and other agents in the list. This also means it is not safe to use the replay feature while a vehicle is 
in flight.  

To open the Replay window in the VC, go to the View menu on the VC's Main screen and select Replay 
window. The following window appears. 

 
1. Play Forward – Press once to start replay in the forward direction. Press again to pause replay. 

2. Replay Speed – Select the speed at which the replay will happen. 

3. Position Slider – Where we are in the replay file. 

4. Single-step Buttons – Move forward/backwards one record in the replay file. 

5. Play Reverse – Press once to start replay in the reverse direction. Press again to pause replay. 

6. Messages Embedded in the Log File – For very advanced users. 

7. Replay File Statistics – Shows miscellaneous data about the file being replayed. 

 
Replay Window Functions. 
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8. Time Stamp in Log File at Current Position – Shows the time the current record in the replay file 
was written. 

9. End Position – Shows the number of records in the replay file. 

10. Current Position – Shows the current record number in the replay file. 

11. Open Data Log Button – Use this button to select a replay file. 

Click the Open Data Log button to browse for the data log file that will be replayed. Note that only 
Matlab-format files (filename ends in *.m) and binary telemetry files stored by the Kestrel 3 Autopilot on 
its SD card (filename ends in *.bin) can be replayed.  By default, the VC loads Matlab-format files stored 
by the VC.   

To load binary files from the Kestrel’s SD card, select Binary Replay File in the Open File dialog. 

 
Binary Replay File. 

After the file is selected, the Replay window validates the file and displays statistics about the file in the 
Replay window. 

At this point, users can press Play Forward at .5X, 1X, 2X, and 4X speeds. Pressing the Play button again 
causes the replay to pause. The user can also reverse-play the data log. At any time, the position slider 
may be grabbed and moved to a position in the data log. When the user presses the Close button in the top 
right corner of the Replay window, the data log will be closed and the VC will return to its previous 
settings. 

The Play ALL checkbox tells the system not to skip any records while replaying the data log file, even 
when playing at 4x speed. This should be left checked, unless the user’s PC is slow and the user does not 
need to see all records.  

NOTE: Play ALL applies only to play-back via the Play Forward and Play Reverse buttons. Play ALL 
does not apply to dragging the scroll bar. 

As shown in the figure’s number 7, this Replay window displays statistics about the replay file and 
advanced debugging information. As shown in the figure’s number 6, this Messages window displays 
messages embedded in the data log file; these functions are intended for advanced users. 

5.7 Creating and Loading Maps 
The VC has the ability to display geo-rectified images in the map display. This greatly aids in flight plan 
preparation and in monitoring a UAV’s location during flight. To properly geo-locate map images, the 
VC uses a world file (*.wf extension) for each image. A world file is a text file that specifies the 
geographic location of the upper-left corner on an image as well as the resolution, in pixels/meter, along 
the width and height axis of the image. When a map image is loaded into the VC, the VC will attempt to 
automatically load a world file of the same name as the image, with a *.wf extension. 
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5.7.1 Creating Maps 
To create maps for the VC, two separate applications are needed: the VC map maker application (shipped 
and installed with the VC) and Google Earth (the free version is adequate). Following are the steps.  

1. Download Google Earth – Go to http://earth.google.com/ and download the Google Earth install. 
Either the free version or Google Earth Plus may be used. In this document, we use the free version. 
NOTE: When using the free version of Google Earth, the saved map resolution is no greater than the 
display of the computer used. 

2. Install Google Earth – Follow the standard or default options for installation. 

3. Run Google Earth 

4. Configure Google Earth 
a. Find the Google Earth Options dialog window under the Tools dropdown menu.  
b. Change the Lat/Long display method (green arrow) from Degrees, Minutes, Seconds to 

Decimal Degrees.  
c. Find Elevation Exaggeration (red arrow) in the Terrain group and change it to the lowest 

number allowed (usually 0.01).  
d. Then press OK. If desired, hide the navigation aids in the upper right-hand corner of the map 

using the View menu – View\Show Navigation\Never. 

 
Google Earth Options.  

 
5. Prepare an Image in Google Earth 

a. Navigate in Google Earth (panning and zooming) until Google Earth shows the map as 
desired.  

b. Press the ‘r’ key on the keyboard occasionally to keep the image axis-aligned and orthogonal 
to the screen. (The ‘r’ key resets the tilt and heading.) 

  
 

http://earth.google.com/
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6. Create a VC Map Out of the Displayed Image – Once Google Earth is displaying the desired map, 
perform the following: 

a. Press the ‘r’ key once more, ensuring the image is aligned and orthogonal. 
b. Launch the Map Maker Application from the VC’s F7 Map Settings screen by pressing the 

Launch Map Maker Application button on that screen. 
c. When the Map Maker comes up, press File/Google Earth Import. The current view is 

captured along with four control points at the corners of the image. 
d. Press the Make Map button – brings up a Save dialog window.  
e. Select a location and name for the image and the world file. 
f. Click OK.   
g. Image is then geo-rectified and the two files are saved. 

At this point, additional maps can be created using the Map Maker Application, and Google Earth can be 
exited. 

5.7.2 Loading Maps into VC 
To add a geo-rectified image to the VC’s map display:  

1. Navigate to the F7 Map Settings screen. 

2. Press Add.  

3. Select Color Image from the Map Type drop-down list. 

4. Press the Load button to browse to the image file location.  

Once the user has specified the image file name, the VC looks for a world file (WF extension) with the 
same name in the same directory.  

• If a valid world file is found, the map is loaded.  
• If no world file is present, the world file parameters can be manually entered into Add Map Item 

dialog. 

5.8 Adjusting Vehicle Parameters 
The Virtual Cockpit gives the user access to Kestrel 3 Autopilot settings unavailable on the 
Handcontroller. 

5.8.1 Failsafes 
The F5 Failsafes screen (following figure) is used to configure the autopilot failsafe behavior. The 
autopilot takes these actions when unexpected events occur. Each failsafe can be individually enabled. 
The F5 Failsafes screen shows each failsafe and status for each. 

NOTE:  Some versions of the VC do not have the Upload Settings button on the Failsafes screen.  If your 
version of the VC reflects this status, there is no point in changing any values on the Failsafes screen, 
since the user will not be able to upload changes to the Kestrel 3. 
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F5 Failsafes Screen. 

Failsafes are subdivided into two categories:  

• Associated with a Fly-By-Wire (FBW) mode 
• Associated with a Guidance mode 

By configuring these failsafes, the user specifies vehicle behavior relevant to each category.  

As described below, each failsafe consists of one or two behavioral stages triggered by an event such as 
loss of GPS signal, user-defined timer, or a measured value falling below a user-specified threshold. In 
addition, each failsafe can be enabled/disabled by checking/unchecking the associated checkbox.  

Fly-By-Wire (FBW) Modes 
1. Low Battery: The low-battery failsafe while in an FBW mode alerts the operator of a potentially 

dangerous low battery situation onboard the vehicle.  
a. User specifies Stage 1 voltage level (e.g., 14.7 in figure below).  

 
Failsafes Available in an FBW Mode. 
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b. When the onboard battery level falls below this threshold, the Kestrel 3 Autopilot cuts vehicle 
throttle 20% to enable a slow descent and to further alert the operator that the failsafe is 
active.  

c. The user also specifies the Stage 2 voltage level (e.g., 14.2 in figure). If the onboard battery 
voltage falls below this value, the Kestrel 3 Autopilot will land the vehicle at its current 
location.  

d. The Stage 2 voltage level should be chosen to represent a critical battery level where only a 
few minutes of flight time remain. 

2. Loss of RC: This failsafe defines vehicle behavior in the event the communication link with the 
safety pilot’s radio transmitter is lost while operating in an FBW mode. When this signal is lost, the 
Kestrel 3 Autopilot enters a hover mode. If GPS signal lock is not held, the vehicle will hover using 
onboard sensors only and its position will likely drift. If a GPS lock is held, the vehicle will hover for 
the amount of time the user specifies (e.g., 30 seconds as shown in the figure) before flying to either 
the Rally or Home position chosen by the user (e.g., Rally in the figure). 

The vehicle will continue to hover in Stage 2 unless GPS lock is not held or the vehicle cannot 
communicate with the VC. In the case of no GPS lock, the vehicle will land after a user-defined time 
delay (e.g., 10 seconds as shown in the figure). In the case of no communication with the ground 
station, the vehicle will land at the pre-specified landing Waypoint or Home location, as chosen by 
the user (e.g., Waypoint in the figure) after a user-defined time delay (e.g., 30 seconds as shown in 
the figure). 

3. Loss of GPS: If GPS lock is lost while operating in a FBW mode, the Kestrel 3 
Autopilot will smoothly transition to FBW Manual mode that does not require GPS. 

Guidance Modes 
1. Low Battery: Similar to the low-battery failsafe in a FBW mode, this failsafe alerts the operator of a 

potentially dangerous situation of a low battery onboard the vehicle. The voltage levels specified for 
Stage 1 and Stage 2 are linked with those specified for the FBW mode low-battery failsafe, so the 
user need only choose these values once.  

a. For Stage 1, the user can specify the vehicle behavior by choosing Fly to Rally, Fly Home, 
Land at Waypoint, or Land at Home from the dropdown menu (e.g., Fly to Rally as shown in 
figure). 

 
Failsafes Available in a Guidance Mode.  

2. Loss of GPS: A loss of GPS while in a Guidance mode will cause the Kestrel 3 Autopilot to hover 
using onboard sensors only and its position will likely drift.  

a. After a user-defined timeout (e.g., 10.0 seconds as shown in above figure), the Kestrel 3 
Autopilot will land the vehicle at its current location.  

b. The user can either allow the failsafe to carry out this landing or can take over by switching 
into a FBW mode and avoid the landing. 

3. Loss of Comm: When enabled, this failsafe is activated if communication with the VC is lost while 
in a guidance mode. The user can specify a timer before the Stage 1 action is taken (e.g., 30.0 seconds 
as shown in above figure).  
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a. This is helpful in the event the user needs to quickly swap the battery powering the laptop 
running the ground station software. In addition, the user can decide whether the Kestrel 3 
Autopilot should Fly to Rally or Fly Home (Fly to Rally as selected in the above figure) in an 
effort to regain communication with the ground station.  

b. In Stage 2, the user can again choose a timer (30.0 seconds in above figure) and a behavior 
from three options: Land at Land Wpt, Land at Home, and Do Nothing (choose Land at Land 
Wpt as shown in the above figure).  

5.8.2 Magnetometer Calibration 
Magnetometer calibration is necessary whenever a new GPS board is installed, when flying in a new 
major geographical area, or when flight tracking performance has degraded. 

A mag calibration is best performed with two people; one person to operate the VC and another to 
manipulate the vehicle during the calibration. The person holding the vehicle should remove any large 
metal or electronic objects (such as cellphones) from their person and stand away from buildings, cars, 
etc. An open field is a good place to perform a mag calibration.  

Mag calibration is performed by following these steps: 

1. Move to the location where the mag calibration will be performed, and verify communications with 
the vehicle in the VC. Pick up the vehicle and hold it by its arms. Make sure it is above waist height 
(at least 3 feet off the ground).  

 
Step 2.  

  
2. In the VC, bring up the F5 Mag Cal screen. Be sure to select the Tumble option, not Compass Swing.  

3. Follow the directions as outlined in the Mag Cal page. 
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Step 4.  

4. To verify the calibration, position the vehicle on known TRUE headings. If the mag readings on the 
Artificial Horizon are within +/-3 degrees, press update flash to store the calibration permanently on 
the Kestrel 3 Autopilot. Otherwise, press the reject calibration button and repeat Steps 1-3. 

NOTE:  

• The VC F5 Mag Cal screen contains a video that demonstrates how to move the vehicle during the 
calibration procedure. 

5.8.3 Uploading Parameter Changes 
Upon changing the various VC engineering screens, some changes are sent to the Kestrel 3 Autopilot as 
soon as the user presses Enter. The user can tell this happened if the field turns yellow and then white 
again. Other changes require pressing an Upload button in order for the changes to be sent to the Kestrel 3 
Autopilot. The user can tell these when a button labeled Upload turns from white to red color upon 
making the change. Red color means the change has not been uploaded to the Kestrel 3 Autopilot. 

Following is the color scheme: 

• Red – Change made in the VC, but that change has not been sent to the Kestrel 3 Autopilot. Press the 
Upload button to upload the change to the Kestrel 3 Autopilot.  

• Yellow – VC has sent the information to the Kestrel 3 Autopilot and is waiting for a response.  
• Button stays Yellow – If the button remains yellow for a lengthy time, it is possible the 

communication link with the autopilot is poor/lost, which may require diagnosis. 
• Yellow and then Red – If the button turns red after it was yellow, it means the Kestrel 3 Autopilot 

rejected the change. This could indicate an invalid value or a compatibility problem between the 
Kestrel 3 Autopilot and VC. 

• Yellow and then White – If the button turns white after it was yellow, it means the Kestrel 3 
Autopilot accepted the change and sent back an acknowledgement. The change is now applied to the 
Kestrel 3 Autopilot.  

Changes uploaded as described in this section remain in effect on the Kestrel 3 Autopilot as long as power 
continues to the Kestrel 3. Changes are lost if the Kestrel 3 is rebooted.  

 

 



 

Copyright © 2014 Lockheed Martin Corporation 

All Rights Reserved 
5-46 

 

5.8.4 Updating Flash/Making Changes Permanent 
When changes are uploaded to the Kestrel 3 Autopilot from the various VC engineering screens, the new 
values are stored in the Kestrel 3 Autopilot’s temporary memory. This causes the Kestrel 3 Autopilot to 
notify the VC that changes have been made that will be lost if the Kestrel 3 Autopilot is rebooted.  

The VC indicates this condition by setting the color of its various Update Flash buttons to red. 

 
To make the changes permanent, the user must press one of the Update Flash buttons, which will cause it 
to turn yellow for 4-5 seconds while the Kestrel 3 Autopilot commits the changes to permanent memory.  

Once the process is complete, the Kestrel 3 Autopilot will tell the VC that there are no longer any changes 
that will be lost by a Kestrel 3 Autopilot reboot and the Update Flash buttons turn grey/white again.  

 
NOTE: It is very important to not interrupt the Kestrel 3 Autopilot’s power during the update (the buttons 
are yellow). Doing so can corrupt the Kestrel 3 Autopilot’s memory. 

5.9 GPS Sim Mode 
Kestrel 3 Autopilot units contain a built-in simulator the user activates by putting the Kestrel 3 into GPS 
Sim Mode.  

GPS Sim Mode is a mission-level simulator – it simulates the functionality of a well-tuned Kestrel 3 
Autopilot in a generic vehicle. It does not simulate actual vehicle dynamics. 

 
Enabling GPS Sim Mode. 
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Initiating GPS Sim 
GPS Sim Mode is an excellent tool for training and flight planning.  

1. Establish communications with the Kestrel 3 Autopilot using one of the techniques described in 
Section 5.2 Establishing Communications.  

2. Navigate to the F5 Variables and Flash screen. 

3. On the left-hand side of that screen, in the Autopilot Variables column, locate Group Sim and open it 
by pressing the adjacent [+] button (red arrow in the picture above). 

4. Scroll down to float ‘GPS sim start latitude’ (green arrow). This, and the two items after it, specify 
where the aircraft will appear when GPS Sim mode is started. Since GPS Sim Mode simulates the 
behavior of a GPS receiver, it is necessary to tell the Kestrel 3 Autopilot where to put the aircraft 
when the simulation is started.  

NOTE: It is expected that users will want to have simulations take place over the map(s) they have loaded 
into the VC; see Section 5.7 Creating and Loading Maps.  

Configuring GPS Sim Starting Location 
To get the latitude/longitude of a map: 

1. Navigate to the F7 Map Settings screen, highlight the map of interest. 

2. Press the Center button to center the Map Display over that map. (Be sure Follow UAV is turned OFF 
before doing this – on the same map setup screen.)  

3. Dismiss the map setup screen and move the mouse pointer over the Map Display in the main VC 
window. The latitude/longitude under the mouse pointer are displayed at the bottom of the VC’s Main 
Window.  

4. Copy these values into the appropriate fields on the F5 Variables and Flash screen. 

5. Scroll up to the GPS Sim (blue arrow).  

6. Type a “1” into that field and press Enter. 
a. This puts the Kestrel 3 Autopilot into GPS Sim mode, which makes it act as if it had GPS 

Lock and makes the following popup dialog appear (if the Kestrel 3 Autopilot did not already 
have GPS lock).  

7. Press OK to dismiss this popup dialog. 
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Set Launch Altitude Dialog.  

 
NOTE: The user can tell that the Kestrel 3 Autopilot is in GPS Sim Mode by looking for the red 
Simulation Mode Enabled message in the message window. 

Shortcut to GPS Sim 
A GPS Sim button is also available in the Advanced Modes group (see Section 5.1.1 VC Main Screen).  
To make the Advanced Modes group appear, use View/Advanced Modes on the Main Menu. To control 
what buttons show in the Advanced Modes group, use View/Customize Advanced/Payload buttons on the 
Main Menu. The GPS Sim button, when shown, will be colored green when the currently-selected agent 
is in GPS Sim mode. 

Utilizing GPS Sim 
Once the vehicle is placed in GPS sim mode, the user can now proceed to flight-plan, preflight, and 
conduct missions as normally performed. As mentioned above, this is an excellent tool for training but is 
also very helpful in pre-planning missions and to maintain currency.  

When the simulation is complete, take the Kestrel 3 out of GPS Sim Mode by rebooting the Kestrel 3. 

NOTE: GPS Sim Mode causes the Kestrel 3 to ignore its sensors. That means the Artificial Horizon will 
not react to tipping the Kestrel 3/vehicle, covering the air speed sensor tube (as is done in the preflight), 
etc. 

Warning: Great care should be taken when entering GPS Sim as the Indago motors may 
unintentionally arm if the above instructions are not carefully followed.  
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5.9.1 Shortcut Keys 
The Virtual Cockpit supports keyboard shortcuts that enable common operations, and bring up the 
following windows and settings: 

• F3 – Continues Search In Variables Window 
• F4 – Displays Add Agent Window 
• F5 – Displays UAV Settings 
• F6 – Displays Communications Settings (Commbox or 3DR Modem) 
• F7 – Displays VC Settings 
• F8 – Displays Video Window 
• F9 – Displays Simulation Handler Window 
• +/- – Zooms In and Out On Map 
• [ / ] – Changes Layers In and Out 
• Pg Up/Pg Dwn on settings screen – Switches Settings Screens 
• Pg Up/Pg Dwn on main screen – hides/shows top part of right-hand map pull-out (Map Settings and 

Layers) 
• Ctrl-a – Displays Add Agent Window 
• shift-ctrl-c – Displays Agriculture Camera Window 
• shift-ctrl-d – Displays Communications Debug Window 
• shift-ctrl-g – Puts all the waypoints on a grid 
• a/s – Adjusts throttle or altitude 
• ,/. – Adjusts camera zoom 
• r – In simulation – resume all 
• Ctrl-left-mouse-click – Adds a waypoint to the map at the current mouse position 
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6 Operating the Vehicle 

This section discusses vehicle operations including setting up the system, preflight, autopilot 
preflight, validating payload, mission setup, flight operations, and emergency procedures. 
 
6.1 Equipment Checklist 
• Handcontroller (battery charged) 
• Laptop with properly installed Virtual Cockpit 2.5H (Optional) 
• Indago vehicle 
• Indago flight battery  
• Indago Payload 
• Repair kit/tools (props, hardware, etc.) 
• Preflight checklist 

6.2 Setting up the System 
1. Unpack vehicle (see Section 3 Indago Details). 

2. Power on Handcontroller and/or optionally connect (wire or wirelessly) the equipped VC 2.5H laptop. 

3. Attach Payload.  

6.3 Preflight the Vehicle 
6.3.1 Cold Start Vehicle Hardware Preflight 
Before each flight, it is important to inspect the Indago system for damage, loose parts and wear. The 
Indago is a highly optimized vehicle that may not function properly or safely with damaged components.  

Vehicle Hardware Inspection 

 
Step 1.  

 
Step 2. 

1. Check each arm wire harness at hinge point for binding and wear. 

2. Ensure wire connector is fully seated and secure. 
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Step 3.  Step 4.  

3. Inspect all propellers for damage including dings, scratches, cracks or crushed midsections. 
a. Always replace both blades of a damaged propeller as they are specifically factory matched. 

4. Check propeller root friction by pivoting each blade about the pin.  
a. Proper friction is obtained by adjusting the hand prop-nut until the blades just barely stay in 

place when the vehicle is held sideways. Ensure prop-nut is firmly in place. 

 

 

 

 
Step 5. Step 6. 

5. Check proper propeller direction on each motor. The direction of each blade should match with the 
direction arrow on the top inside face of the arm clip (see Section 3.3.1 Propeller Replacement for 
more detail on identifying propeller direction and how to tell they are installed right side up). 

6. Spin each motor bell to ensure there is no resistance or binding.  

a. Encumbered rotation could be a result of debris in the motor or a sign of a damaged motor 
bell. 

b. Use compressed air to blow out dirt and other foreign matter from between the rotating bell 
and stationary stator. 
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Step 7. Step 8. 

7. Pull up on each motor bell to make sure it doesn’t pull off from its base. This is to check that the 
retaining clip on the motor shaft is still intact. 

8. Ensure that all landing gear legs and vehicle arms are fully extended and locked into place. 

9. Inspect all vehicle hardware to ensure nothing is missing or loose, including:  

 

 

 

 

 
Step 9a. The three motor pod screws on each arm. Step 9b. The landing gear bolt on each arm. 
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Step 9c. Arm clip clamp bolt on each arm. Step 9d. Arm clip pivot bolt on each arm. 

 
 

 

 

 

 

 

 

 

 
 

Step 9e. All four shell screws. Step 9f. The two battery hatch hinge bolts and 
nuts. 
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Step 10. Step 11. 

10. Inspect battery compartment for foreign objects and debris. 

11. Ensure payload is properly and fully seated (if necessary). 

6.3.2 Hot Start Vehicle Hardware Preflight 
Follow this procedure when subsequent flights are performed the same day: 

1. Check props for dings, cracks, and abnormalities.  

2. Check prop tension. 

3. Check motor bell for excessive slop/grittiness. 

4. Pull up on the motor bells to check that the motor shaft retaining clips are still in place. 

5. Check that no screws are missing or loose. 

6. Verify that landing gear is positioned and locked. 
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6.4 Autopilot Preflight 
1. Power on the Indago by inserting the battery into the vehicle. 

2. Establish communication with the vehicle (for detailed instructions, please refer to  
Section 4 Handcontroller Details, and Section 5 Virtual Cockpit Details). 

3. Verify Indago Battery Voltage – A fully charged battery has a voltage of 16.8V.  
a. Do not attempt to fly if the resting battery voltage is less than 14V. This can be checked in 

the vehicle status bar across the top of the Handcontroller or Agent status list on the VC as 
shown:  

 
 

4. Verify GPS Lock – Usually requires reception from four or more satellites.  
a. The numbers of satellites detected is displayed in the Agent Status list.  
b. The dilution of precision and speed accuracy values are displayed in the Artificial Horizon.  
c. The UAV will only appear in the correct location on the map after GPS lock is acquired. 

 

 
Determining Numbers of Satellites. The numbers of satellites (up to nine) is displayed in the Agent 
Status list. The Artificial Horizon includes Dilution of Precision (DOP), speed accuracy, numbers of 
satellites, and average GPS signal strength (circled). 

Warning: If at least seven satellites are not detected, DO NOT FLY. Also DO NOT FLY if the GPS 
speed accuracy is >1.5 or DOP is >3. Adequate GPS data is more important with hovering vehicles than 
with fixed-wing vehicles. 

5. Verify Attitude – If the VC is in the loop, verify that attitude changes with the vehicle are properly 
reflected in the Artificial Horizon. 

6. Verify Wireless Range – Periodic range checks are appropriate to verify the proper function of the 
communication link. 

a. Remove the antenna from the Handcontroller and ensure communications with the vehicle 
continues when it is on the ground approximately 50-100 feet away. 

7. Sensor Checks and Failsafes – Prior to each flight, it is required that the user perform a series of 
sensor checks to ensure proper sensor function.  

a. On the Handcontroller, this process is condensed to one button called Sensor Check. 
b. The VC requires the use of four buttons as indicated: 
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Following are the Pre-Flight button functions as shown in the above menu:  

Zero Press. – Enter Zero Press to zero the current altitude of the autopilot. This step is necessary 
because barometric conditions can change and we want to avoid false readings. After zeroing the 
pressure, the altitude should show less than 2 meters from zero. 
GPS Home, Set GPS Home Position – Upon gaining GPS lock, the Home position is set.  

•  Reset the Home position by pressing the GPS Home button, which sets Home at the current 
UAV position.  

•  Verify that the GPS has acquired satellite lock. The Home position is displayed on the map. 
Note that upon taking off, the GPS Home position is moved to the UAV location at takeoff. 

Check Sensors – Upon pressing this button, the autopilot performs a check on its individual 
sensors (magnetometer, accelerometers, gyros, etc.) to ensure they are within operational 
tolerances.  

• It is imperative during this process that the vehicle is not being handled, and is approximately 
level. 

FS for Verifying Failsafes – Pressing this button opens the autopilot Failsafes Setup window as 
shown in the following figure.  

• The autopilot failsafes handle failure conditions including Loss of Communications, Loss of 
GPS, and Low Battery conditions – and are set by default for a generic Indago mission 
profile. 

 
Failsafes Setup Window. 
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6.5 Validating Payload 
Prior to each mission, the user must validate that the payload is functioning properly. The process is a 
little different for each payload. Following are generic items to check before going airborne: 

• Live video feed 
• Mux between cameras (if applicable) 
• Zoom in and out 
• Tilt the gimbal through its range of motion 
• Preform flat field calibration (if applicable) 
• Take a snapshot (if applicable) 

6.6 Mission Setup 
The following describes how to set up a mission using the VC. To set up a mission using the 
Handcontroller, see Section 4 Handcontroller Details. 

A Flight Plan may be created by adding individual waypoints. Pre-saved Flight Plans may also be loaded 
from file.  

6.6.1 Adding Waypoints to the Flight Plan 
1. To add waypoints to the Flight Plan, right click over the map and select a waypoint under Insert 

Commands as shown. 

 
Add Waypoint Using Map. 

2. Flight Plans may be loaded and saved either by using the Load and Save options under the File drop-
down menu or by using the Load/Save buttons above the Flight Plan.  

a. Default waypoint parameters are recommended for first time use.  
b. Waypoint types (Flight Plan items) are described in detail in Section 5 Virtual Cockpit 

Details. 
c. Note: Prior to getting GPS lock, the icon representing the UAV and Home location will not 

appear on the map area. 

In addition to normal flight waypoints, the Flight Plan includes Takeoff, Rally, and Land waypoints.  

3. If those points do not appear on the map area, select Move Takeoff/Land Here after right-clicking on 
the map.  

a. The user can set up the entire Flight Plan and landing sequence prior to getting GPS lock.  
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b. Save Flight Plan(s) for use upon arriving at the flight location. 

6.6.2 Editing Waypoints 
As users add waypoints to the Flight Plan, waypoint parameters such as Altitude and Airspeed (default 
values set) may be edited. Edit waypoint properties either by double-clicking on the waypoint on the map 
or by using the Flight Plan List. To reveal the Flight Plan, click the tab at the bottom center of the map. 

 
Step 1. Editing a Flight Plan Waypoint in the Flight Plan List. 

6.6.3 Uploading the Flight Plan 
1. Upload the Flight Plan by pressing the red button (displays agent number on the red button) 

at the top right corner of the map area. This indicates the Flight Plan is different from that 
on the autopilot and must be uploaded.  

6.6.4 Current Flight Plan Item 
The current waypoint is highlighted on the map and is listed in the Flight Plan tool bar.  

1. Choose to fly to any waypoint at any time by right-clicking on the waypoint on the map 
and selecting Set As Current Command, or by changing to the desired waypoint number 
in the Cmd # box and pressing Enter. The UAV will then proceed to that waypoint. 
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6.6.5 Takeoff and Landing Points 
Takeoff and Landing Points are considered separate from the NAV waypoints but are uploaded to the 
autopilot as part of the Flight Plan. The Takeoff waypoint is used for Takeoff Mode. In this mode, the 
UAV first spins up the motors and lifts off the ground. It then transitions to the Takeoff Waypoint. 

Once reaching the Takeoff Waypoint, the UAV will hover indefinitely. Users have to manually change 
the UAV Mode to command the vehicle out of the hover (for example, switch to autonomous navigation 
mode by selecting the Nav button). 

There are two landing modes: 

1. Land Now – Vehicle will begin an immediate decent at its current position. 

2. Land Wpt – Vehicle will first transition to the Land Point. Upon reaching the Land Point, the vehicle 
will initiate a decent. NOTE: If above the set Land Point Altitude when transitioning, the vehicle will 
descend to that altitude before reaching the Land Point.  

 
After contact with the ground, the vehicle will autonomously go through its landing sequence and disarm 
the motors.  

6.7 Flight Operations 
6.7.1 Mission Briefing 
All roles should be fully understood by all crewmembers. The Pilot in Command needs to understand the 
command responsibilities, and manual takeover procedures. The mission objectives, expected behaviors, 
and emergency procedures need to be outlined. It is also important to understand current and forecasted 
weather conditions. 

6.7.2 Retasking 
At any point during the mission the user has the ability to retask the vehicle. Simply insert an additional 
waypoint or modify an existing one. For these changes to take affect the Upload button must be pressed. 
Alternatively, the user has the ability to retask the vehicle through a series of overrides available in the 
right hand pull-out of the VC (i.e., heading, airspeed, altitude). 

6.7.3 Vehicle Health 
It is important to frequently scan the received vehicle health telemetry during flight to be aware of the 
current vehicle status. These items include the Spider Display, Virtual Horizon, Idiot lights, and Message 
window. For details, see Section 4 Handcontroller Details, and Section 5 Virtual Cockpit Details. 
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6.7.4 Payload Operation 
Depending on whether the Handcontroller or VC is being used, see Section 4 Handcontroller Details, and 
Section 5 Virtual Cockpit Details for details. 
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6.7.5 Battery Monitoring 
The Kestrel 3 Autopilot monitors the state of health of the battery while powered by an appropriate 
Lockheed Martin battery. The health information is displayed in two places.  

Monitoring Via Artificial Horizon Screen 
The first of these is at the bottom of the Artificial Horizon on the VC as shown in the figure below.  

 
            Battery Summary Data in Artificial Horizon. 

As shown in the above figure:  

• The battery is fully charged and there are 36 minutes of flight time remaining; this corresponds to 138 
Watt-hours of capacity.  

• The battery is currently providing 16.6V to the aircraft, which is drawing less than 300 mA (the lower 
limit of the measurement envelope) or 3W. 

Monitoring Via Payload Control Screen 
The other place the battery information is displayed is on the Payload Control screen of the VC as shown 
in the figure below.   
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Battery Health Data on Payload Control Screen. Display includes Serial Number, Configuration 
Version, Number of Cycles, Battery Health, Status, Remaining Capacity, Temperature, Power being 
provided, and pack and cell voltages. 

The Virtual Horizon displays critical information so the operator can determine battery health at a glance. 
The Payload Control screen displays detailed information that is helpful in diagnosing battery pack issues. 

NOTE: Within the Payload Control screen are Individual Cell Voltage displays (V #1-4), Cell Voltage 
Gap (Vgap), and Battery Health display.  
• Individual cell voltages are important because if a single cell is allowed to discharge or charge 

significantly more than any others, the pack can be damaged.  
• Voltage gap (Vgap) value is the difference between the highest and lowest cell voltages.  
• Lockheed Martin Procerus Technologies recommends landing immediately if the voltage gap 

noticeably exceeds 400 mV.  
• The Health field of the Battery display indicates the battery’s chemical capacity. This is expressed as 

a ratio of measured capacity (in Watt-hours) to designed capacity (in Watt-hours).  

6.8 Emergency Procedures 
An essential part of successful operation of any UAV is having a firm understanding of failsafe 
procedures and what to do in the event of an emergency. See Section 5.8.1 Failsafes for greater detail of 
the failsafes’ behaviors.  
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6.8.1 Abort/Emergency Landing 
Handcontroller 
During Spool up (still on ground) – press and hold disarm button. 
During takeoff (<3m off ground) – press and hold disarm button. 
Airborne/ Navigation:  
Option 1 – Press guidance mode Land button 

Option 2 – Take over in HC-POS and command vehicle to the ground, then press and hold 
Disarm button 

Virtual Cockpit 
During Spool up (still on ground) – click the Armed button. 
During takeoff (<3m off ground) – click the Armed button.  
Airborne/ Navigation: 

Option 1 – Press Land Now 
Option 2 – Select Home then Land Now 
Option 3 – Select Land Wpt 

6.8.2 Intermittent/Loss of Communication 
Option 1: Let Loss of Communication Failsafe run its course. If properly configured for the 

mission no harm should be done to the vehicle. 
Option 2: Troubleshoot the situation. 

Handcontroller: Check antenna connections and orientation 
Indago: Determine line-of-sights and altitude conditions 
Mission: Consider landing as soon as possible 
Comm link:Troubleshoot issues 

6.8.3 GPS Failure 
In case of GPS failure, take one of the following actions:  

Option 1: Take the vehicle in HC ALT mode and manually fly the vehicle (either by sight or by video) to 
a safe location; land the vehicle. 

Option 2: If in a Guidance mode when GPS is lost, let the Loss of GPS Failsafe run its course. If properly 
configured for the mission and vehicle is in an area safe for an autonomous landing, the vehicle should 
not be harmed. 

6.8.4 Low Battery 
Guidance Mode – If in a guidance mode and a low battery failsafe is triggered, it is best to let the failsafe 
run its course. If properly configured for the mission, the vehicle should experience no harm.  

Handcontroller Mode – If in a Handcontroller mode the user notices the vehicle requires more throttle to 
stay airborne, this indicates the battery is getting low. The user must find a suitable landing location prior 
to Stage 2 (or Critical Battery) Failsafe kicking in. 

Low Battery Failsafe – In the event the user continues flying through the low battery failsafe, Stage 2 
critical battery failsafe will be encountered. This is not something the user should routinely fly to, and 
could potentially cause great harm to the vehicle and surrounding property.  

• Once in this failsafe the vehicle will initiate an Emergency Land Descent and immediately begin 
descending toward the ground.  

• The user still has the ability to manipulate the vehicle in the X/Y plain to avoid any obstacles below.
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7 Charger 

This section describes methods of charging the Handcontroller battery and Indago battery using 
the Indago battery charger, store charging, and steps to take for maximizing battery life. 
 

 
 Charger for Indago Battery and 

Handcontroller Battery. 
 

The Indago Battery Charger System is designed to charge both the Handcontroller and Indago battery 
packs quickly and safely.  

The charger runs via standard 110V AC outlets as well as 24V DC sources. If only 12V DC is available, 
the Indago battery may still be charged, but the Handcontroller battery cannot. The charger also store 
charges the Indago battery to maximize life.  

7.1 Battery Care 

 
Indago Lithium Polymer Batteries. 

• Do not deep discharge lithium polymer batteries as this damages the batteries.  
• Deep discharging means draining a battery below 3V/cell. Deep-discharged batteries become 

dangerous and this battery condition significantly shortens vehicle flight time.  
• The Handcontroller has built-in protection that shuts down the controller when this threshold is met.  
• The system has a failsafe that lands the vehicle as the low-voltage threshold is approached. The 

system will not, however, stop draining the battery.  
– Promptly remove the Indago battery after landing to avoid deep discharging.  
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7.2 Indago Battery Charging 

 

 
 

 

Step 1. Step 2a. 

To charge the Indago battery using the Indago battery charger:  
1. Connect the AC power cord or 12-24V DC to the charger to power on the charger.  

a. The small LCD screen should light up with text displayed.  

2. Insert the Indago battery into the Indago battery slot, ensuring it is seated fully. 
a. The charger should display text as shown in the figure.  
b. If not, press the right or left arrow until this screen appears.  

3. Begin the charge by pressing and holding the Enter button until charging begins.  
a. The charger will charge the pack in roughly an hour and stop automatically. 

4. Press the stop button to revert back to the charger Home screen and remove the battery 

7.3 Indago Battery Store-charging 
When not in use, the Indago battery benefits significantly from store-charging. Store-charging puts the 
battery into an optimal state that minimizes battery degradation inherent in all high-discharge batteries.  

Store-charge batteries that will not be used within two weeks to help maximize flight time throughout 
battery life. 

 
Step 2. 

To store-charge the Indago battery: 
1. Turn on the charger and insert the battery.  

2. Press the right arrow key until the screen (shown in figure) appears.  

3. Press and hold the Enter key until store charging begins.  
a. The charger will store the battery and automatically shut off.  
b. Press the Stop button to revert back to the charger Home screen and remove the battery. 
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7.4 Additional Indago Battery Charger Information 
7.4.1 Charger Flow Chart 
While the charger comes pre-programmed from the factory, it is possible to navigate to an undesired 
location within the menus if not careful.  

Follow the flow chart below to navigate back to Balance Charge, Charge, Fast Charge, or Storage Charge. 
It is not recommended that the user adjust any of the configurable parameters of this charger. 

 
Charger Flow Chart. 
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In-depth Charger Manual 
For more information regarding safety, use, and functionality of the charger please consult the in-depth 
charger manual found at this link: 

http://www.progressiverc.com/media/iCharger%20206B%20Manual.pdf 

7.5 Handcontroller Battery Charging 

 
Step 1. 

1. Connect the AC power cord or 24V DC to the charger to power-on the charger.  
2. Drop the Handcontroller battery pack into the charger’s Handcontroller battery slot; charge begins 

automatically.  
a. Battery charge status shows on the small display on the exposed end of the battery. 
b. Flashing bars indicate the pack is being charged and percent to completion.  
c. A full charge from a depleted battery pack usually takes less than an hour.   

http://www.progressiverc.com/media/iCharger%20206B%20Manual.pdf
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8 Description of Warnings 

This section details warnings that may be encountered during normal operation of the Indago 
system. 

8.1 Battery Faults 
Cell Imbalance Warning  
Caused by one of more of the internal cells that make up the battery pack having a voltage that is higher 
or lower than the rest of the pack.  

This is often due to a fatigued or damaged pack. Cell imbalances often lead to shorter flight times and 
continued damage to the pack if the pack is completely discharged.   

Consider replacing the battery pack. 

Cell Imbalance Permanent Fault 
Error occurs when the cell imbalance warning condition has deteriorated to a fault state.  

The pack is no longer serviceable and needs replacing.  

Cell Under-volt Warning 
Caused by one or more of the internal cells comprising the battery pack having a voltage below the low-
voltage threshold of the battery pack; often due to over-discharging the pack.  

A fatigued or damaged pack may cause this condition to occur more frequently. Cell under-volt 
conditions often lead to permanent battery damage, shorter flight times, and continued battery damage if 
the pack is completely discharged.  

Consider replacing the battery pack. 

Cell Under-volt Permanent Fault 
Error occurs when the cell under-volt warning condition has deteriorated to a fault state.  

The pack is no longer serviceable and needs replacing. 

Battery Deterioration Warning 
Caused when the health of the battery falls below the battery deterioration limit (typically 75% of rated 
capacity). This means the battery is becoming fatigued and can no longer provide the energy required for 
normal flight times.   

Consider replacing the battery pack. 

8.2 ESC Faults 
Red-Green Alternating Flash on a Motor Pod 
Indicates that a motor pod did not initialize correctly. Can be caused by a wiring or connection problem 
between the motor pod and the main vehicle assembly.  

Check that the arm is firmly connected to the vehicle and re-power the vehicle. If the problem persists, the 
vehicle may need servicing. 
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8.3 Miscellaneous Warnings 
Protocol Mismatch Error 
This error may occur if a protocol mismatch is detected between various system elements. It is usually not 
a problem and should be disregarded if it infrequently occurs. It is often caused by a mismatch between 
Virtual Cockpit (VC) and autopilot firmware versions.  

Updating to the latest VC and autopilot firmware frequently solves the issue.  

8.4 Kestrel 3 Autopilot Faults in Message Window 
In Flight 
High Vibration Detected – Warning is present when unusually high vibration is detected during flight. 
This error may be triggered by extended periods of fast forward flight in a VTOL aircraft.  

If this error persists during extended hovering periods, the vehicle may need servicing; specifically, the 
autopilot vibration mount or motor pods and props. 

Excessive Vibration Detected – Warning is present when excessively high vibration is detected during 
flight.  

If this error persists during extended hovering periods, the vehicle may need to be serviced. 

Startup/Preflight Errors 
Warning: Motor Pod Missing 
Error is caused by a communication problem between the avionics and a motor pod on the Indago.  

Re-check the arm connection. If the problem persists, the vehicle may need to be serviced. 

Sensor Failures During Pre-Flight Sensor Check 
Gyro Fail: Can be caused by two issues: 1. Movement of the vehicle during Sensor Check routine; 2. 
Hardware or calibration issue with the Gyro.  

Ensure the vehicle is level and run the sensor check a second time. If the error persists, the vehicle may 
need servicing. 

Accelerometer Fail: Can be caused by two issues: 1. Vehicle not perfectly level during Sensor Check 
routine; 2. Hardware or calibration issue with the Accelerometer.  

Ensure the vehicle is level and run the sensor check a second time. If the error persists, the vehicle may 
need servicing. 

Airspeed Failure: Can be caused by two issues: 1. Wind blowing into the pitot tube during pre-flight; 2. 
Hardware or calibration issue with the Airspeed Sensor, clogged pitot, or pitot tube plumbing.  

Check the Pitot system for problems, make sure wind is not blowing into the pitot tube, and run the sensor 
check a second time. If the error persists, the vehicle may need servicing. 

Altitude Failure: Can be caused by two issues: 1. Altitude not zeroed; 2. Hardware or calibration issue 
with the Altitude or GPS sensor.  

Re-click Zero Pressure in the Virtual Cockpit, wait 10 seconds, then run the sensor check a second time. 
If the error persists, the vehicle may need servicing. 

Roll or Pitch Failure: Can be caused by two issues: 1. Vehicle not perfectly level during Sensor Check 
routine; 2. Hardware or calibration issue with the Inertial Sensors.  
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Ensure the vehicle is level and run the sensor check a second time. If the error persists, the vehicle may 
need servicing. 

Temperature Failure: Caused by the avionics being too hot.  

Place the vehicle in shade to allow it to cool, then re-run the sensor check routine. If the problem persists, 
the vehicle may need servicing. 

Mag X/Y Failure: Can be caused by two issues: 1. Magnetic heading sensor not agreeing with the 
estimated heading; 2. Hardware or calibration issue with the Magnetometer.  

Place the vehicle on a level, non-metallic surface (such as the ground) and allow it to rest for 30-60 
seconds to re-align the magnetic heading.  

Run the sensor check a second time. If the error persists, the vehicle may need servicing. 

Warning: No Home Position – Aircraft Navigation Disabled: Warning is present prior to initial GPS 
lock and acquisition of a Home position. This message disappears once GPS lock is acquired. 

Sensor Init Failure – Sensor Init Failure – Flight Disabled 
Error is due to power failure upon internal check of the Accelerometer. It can be incorrectly triggered by 
excessive movement of the vehicle during power up.  

If this error occurs, re-power the vehicle while holding the vehicle still.  

If the error persists, the vehicle may need servicing. 



 

Copyright © 2014 Lockheed Martin Corporation 

All Rights Reserved 
9-1 

 

9 Troubleshooting Guide 

This section describes steps to resolve potential issues with the Vehicle, Payload, Handcontroller, 
Virtual Cockpit, Charger, and Battery – and provides troubleshooting/solutions for each.  
 

9.1 Vehicle 

Vehicle Issue Troubleshooting/Solutions 

Landing gear 
“buzzing” 

Indicates loose landing gear or excessive vibrations.  
• First, try tightening the screw holding the landing gear together.  
• If that does not solve the problem, check for cracked or damaged 

propeller blades, or bent motor bells.  
• Replace any damaged components. 

Broken components: 
landing gear, props, 

arms, etc. 
• Replace any damaged components. 

Flips over on takeoff 

Usually indicates a propeller set was installed incorrectly and is producing 
thrust in the wrong direction.  
• Check to see that the rotation of the blades is correct for their respective 

arms.  
• Arm the vehicle and watch to see that the blades spin in the correct 

direction corresponding to their blades. 

Toilet-bowls/doesn’t 
track straight 

May indicate a poor GPS signal.  
• Fly the vehicle away from buildings and other obstructions to allow for a 

better view of the sky. 
Or, may indicate an improper magnetometer calibration. 
• Recalibrate the magnetometer in VC F5>Mag Cal and follow the 

directions on the page. 

Doesn’t maintain 
altitude 

Vehicle will try to descend when in low battery state.  
• Try a freshly charged pack to see if the problem is remedied.  
• May be a discrepancy between barometric and GPS estimated altitudes if 

Zero Press and GPS Home are not pressed before takeoff. This would 
make the vehicle believe it is higher or lower than it should be. 

Or, autopilot may be improperly vibration isolated.  
• Remove the top shell of the vehicle. 
• Inspect the autopilot to ensure it can move freely on its vibration isolation 

plate and that its movement is not impinged by other components or 
taught wires. 

Motor(s) not spinning 

Fault detected (with alternating color lights). 
• No motor communication. 
Damaged motor component(s). 
• Replace arm. 

Motor(s) spinning 
wrong direction 

Glitch on boot up. 
• Power cycle vehicle; ensure Indago battery is fully seated. 
Damaged arm wires/esc. 
• Replace arm. 

Vehicle vibrating 
significantly 

Improper propeller root friction. 
• Loosen/tighten prop nut as outlined in Section 3.3.1 Propeller 

Replacement.  
Damaged propeller(s)/debris on propeller(s). 
• Clean propeller(s). 
• Replace propeller(s) (BOTH blades). 
Damaged Motor(s). 
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Vehicle Issue Troubleshooting/Solutions 

• Replace arm(s). 

Nav Lights alternating 
colors 

Arm hardware error (motor, controller, wiring). 
• Power Cycle vehicle. 
• Replace arm. 

Short flight time 

Flight pack uncharged or only stored charged. 
• Fully charge Indago battery. 
Damaged vehicle Indago battery. 
• Replace Indago battery (do not fully drain a good Indago battery and 

always store charge packs for periods of unuse to avoid damage). 
Not holding a heading/ 

yawing difficulty 
Yaw bias due to damaged/misaligned motor(s), arm(s), or propellers.  
• Replace damaged motors and propellers. 

Loose arms 

Loose hardware. 
• Tighten arm bolts. 
Damaged arm clip. 
• Replace arm clip. 

 

9.2 Payload 

Payload Issue Troubleshooting/Solutions 

Blurry image 

FLIR IR Camera – Must be flat-field calibrated to show a clear image.  
• Can be accomplished by parking and unparking the camera.  
• Park/unpark button can be found in the Payload Modes.  
• These modes are available above the virtual horizon in VC when they are 

checked ON under the View menu. 
Vibrations – A blurry image can also result from excessive vibrations.  
• Ensure prop-nuts are not too tight.  
• Ensure no cracked or otherwise damaged propeller blades or motor bells. 

Replace if necessary. If the blades look good but are still suspect of 
producing vibrations, weigh each blade set from each motor to make sure 
the two halves are closely matched in weight (<±.2g?).  

• Replace unmatched sets for closely matched sets. 
Gimbal – If the image is still blurry and the vehicle’s vibrations are not 
excessive, the vibration isolation in the gimbal may be worn or damaged.  
• Send in the gimbal for repair.  

No elevation control 

Pogo pins on the payload and payload quick detach can be dirty or corroded.  
• Clean off the pins and contact pads with a clean rag and isopropyl 

alcohol. 
Vehicle may not be configured correctly.  
• Load the proper XML files for the vehicle and try again. 

No video 

Pogo pins on the payload and payload quick detach can be dirty or corroded.  
• Clean off the pins and contact pads with a clean rag and isopropyl 

alcohol. 
Receiver may no longer be functioning.  
• Check its antenna and power input.  
• Verify proper video channel (Vehicles ship by default on analog channel 

#8) 

Camera Muxing not 
working 

Pogo pins on the payload and payload quick detach can be dirty or corroded.  
• Clean off the pins and contact pads with a clean rag and isopropyl 

alcohol. 
Vehicle may not be configured correctly.  
• Load the proper XML files for the vehicle and try again. 
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Payload Issue Troubleshooting/Solutions 

Camera zoom not 
working 

Pogo pins on the payload and payload quick detach can be dirty or corroded.  
• Clean off the pins and contact pads with a clean rag and isopropyl 

alcohol. 
Vehicle may not be configured correctly.  
• Load the proper XML files for the vehicle and try again. 

Lenses scratched 
Care must be taken to avoid scratching the lenses.  
• If the lenses are excessively scratched to the point of degrading video 

quality, send in the gimbal to have new lenses fitted. 
 

9.3 Handcontroller (HC) 
HC Issue Troubleshooting/Solutions 

Can’t establish 
communications 

Wrong modem channel. 
• Assign vehicle and HC to same channel. For details see Section 4.3 

Establishing Communications.  
Can’t get video in HC • Ensure that the HC video channel is set properly. 

Can’t Connect to the 
VC over USB 

• Verify that the USB cable is properly seated in the VC computer and the 
HC USB mini B port. 

• Check that the proper com port is selected in the VC F7 Comm and XML 
settings screen. 

• Check that the com port is opened.  The Open button should be grey. 
• Verify that the HC is connected to the VC by checking for the Commbox-

HC text in the VC message window. 

Can’t Connect to the 
VC over WiFi 

• Verify that the VC computer is connected to the HC WiFi access point. 
• Verify that the VC computer has been assigned an IPv4 address of 

192.168.168.101. This can be done by running ipconfig from a Windows 
command prompt. 

• Check the settings on the VC F7 screen: Enable UDP box should be  
checked; all ports should be set to 20003; the Remote IP should be 
192.168.168.100. 

• Verify that the USB cable is not plugged into the HC.  This will cause 
communication to not flow over the WiFi link. 

• Verify that the HC is connected to the VC by checking for the Commbox-
HC text in the VC message window. 

No HC video stream on 
base computer 

• Verify that the VC computer is connected to the HC WiFi access point. 
• Verify that the VC computer has been assigned an IPv4 address of 

192.168.168.101.  This can be done by running ipconfig from a Windows 
command prompt. 

• Check that the HC is in streaming mode.  The streaming menu option 
should say HGCS->Turn Video Streaming Off. 

• Check that VLC is setup to properly receive the stream –  URL: 
udp://@192.168.168.101:3001 
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9.4 Virtual Cockpit (VC) 
VC Issue Troubleshooting/Solutions 

Can’t establish 
communications 

See Section 5.2 Establishing Communications. 

VC hangs on wake-
up/un-suspend 

Putting a computer/laptop to sleep with the VC running can cause the VC to 
hang when waking the computer up again.  
• Exit the VC before suspending/putting the computer to sleep. 

VC hangs when serial 
port unplugged 

Some USB to serial converters can hang the computer/VC when they are 
unplugged from the computer while they are in use.  
• Close the serial port (F7 screen) or exit the VC before unplugging these 

converters. 

Error about missing 
d3dx9... DLL files when 

running the VC – For 
example, d3dx9_42.dll 

missing 

Computer needs to be updated with the latest Microsoft® DirectX runtime 
libraries. There are two ways to fix this.  
• Rerun the VC installer with computer connected to internet.  

– Agree to do the portion that updates the DirectX runtime libraries.  
• Connect to the Microsoft® website (http://www.microsoft.com/en-

us/download/search.aspx?q=directx). 
– Choose DirectX End-User Runtime Web Installer. 
– Follow the instructions on that website. 

Maps inaccurate 

Either the map’s world file is damaged, or the user who made the map left 
one or more steps out of the map making process.  
• See Section 5.7.1 Creating Maps. 
• Set Elevation Exaggeration to the lowest possible value. 
• Press the “r” key in Google Earth before starting MapMaker. 

Vehicle not visible on 
map Right-click on the map and select Center on UAV.  

More than 15 flight 
items not allowed 

This is normal behavior for the commercial version of the VC.  
• Please contact Lockheed Martin Procerus Technologies if an upgrade to 

the full version of the VC is needed. 

Serial port won’t open 
in the VC 

Port probably in use by another program.  
• Close that program and try again.  
• Note there should NOT be more than one instance of the VC running at 

any time. 

Spider display 
warnings 

High controller temperatures. 
• Operating in excessive temperatures. 
• Damaged motor pulling excessive current. 
• Damaged controller.  
Thrust Offsets. 
• Damaged propeller or motor. 
• Misaligned arms from loose bolts or damaged arm clip. 
Over Current. 
• Damaged motor pulling excessive current. 
• Damaged controller.  
ESC Comms. 
Damaged wiring. 

 

  

http://www.microsoft.com/en-us/download/search.aspx?q=directx
http://www.microsoft.com/en-us/download/search.aspx?q=directx
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9.5 Charger 
Charger Issue Troubleshooting/Solutions 

Getting into wrong 
menu 

Return to lipo menu. 
• Follow the directions in Section 7.4.1 Charger Flow Chart to return to lipo 

charge. 

Handcontroller battery 
will not charge 

Check source voltage. 
• If the charger is connected to the DC input with 12V, the Handcontroller 

battery charger will not operate. It requires a 24V through the DC input or 
120V through the AC input to work properly. 

Int. temp over chg 
stopped 

Charger will reduce its output power by 25% when the internal temperature 
exceeds 140°F (60°C). If the temperature exceeds 150°F (65°C), the 
charging is stopped. 
• Move the charger to a shaded area. 
• Turn off the charger to give it some time to cool. 

Connection break down 

Connection with the Indago battery was interrupted during charging or 
discharging. 
• Press Batt type/Stop to exit the warning. 
• Replace the battery pack and restart charging or discharging. 

Input voltage low 
voltage 

Input voltage is lower than the value set in the USER SET menu. 
• Check to make sure the source voltage is not too low. 
• Change the source voltage to keep it above the value set in the USER 

SET menu. 

Input voltage over 
voltage 

Input voltage is over 32V. 
• Check to make sure the source voltage is not too high. 
• Change the source voltage to keep it under 32V. 

Balance port cell high 
vol 

Voltage of one of the cells is too high. 
• Check the individual cell voltages. 
• The battery pack may be permanently failed; check fuel gauge LCD for 

flickering. 

Balance port cell high 
vol 

Voltage of one of the cells is too low. 
• Check the individual cell voltages. 
• The battery pack may be permanently failed.  
• Check fuel gauge LCD for flickering. 

Safety time out stopped 
Charger reached the set protection time limit. 
• Out of balance battery will take extra time to charge. Please restart the 

charge.  
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9.6 Battery 
Battery Issue Troubleshooting/Solutions 

LCD flickering 
Represents a permanently failed battery that has been over-discharged or 
has too large of a cell gap. The battery pack is no longer safe to fly. 
• Replace the battery pack. 

Indago won’t take off 

If the Indago detects a permanent failed battery in flight, it will try to let the 
Indago finish its current flight. Once landed, the Indago will not be allowed to 
take off with a permanently failed battery. 
• Replace the battery pack. 

Autopilot fails to 
communicate with 

battery 

This typically means the I2C bus may be experiencing issues or the 
connection to the battery communication lines is poor. 
• Try pulling out the battery and plugging it back into the vehicle to see if 

the problem resolves itself. 
• If the problem still exists, try a different battery pack. 

Battery discharged too 
low 

If the battery is discharged low enough to trigger a permanently failed battery 
(see LCD flickering above) then the pack has been damaged and is no longer 
suitable for flight. 
• Replace the battery pack. 

Cell gap too high 
Typically occurs if a battery has been improperly cared for or over-
discharged. If the battery has not triggered a permanent failure: 
• Replace the battery pack. 

Puffy pack 

Typically occurs after a battery has been exposed to extremely high 
temperatures or over-discharged. This may be accompanied by a 
permanently failed battery (see LCD “flickering” above). 
• Replace the battery pack. 
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Appendix A: Flight States 
Introduction to Flight States 
Flight states are a method used by the autopilot to keep track of the overall state of the aircraft’s mission 
and to govern what actions are available at any point in time.  
The current flight state is always displayed in the Flight State Indicator in the Virtual Cockpit (VC) or on 
the Handcontroller (see figure below). 

 
Flight State Indicator Location in the VC. 

There are nine flight states visible to the user. These flight states are: Preflight, Disarmed, Spool Up, 
Ready for Flight, Climb Out, Airborne, Airborne without GPS, Landing, and Landed.  

Flight States Quick Guide 
Flight State Indicator Description Exit State  

Preflight  

The operator is expected to perform 
any preflight tasks and ensure that 
the aircraft is ready to begin flight 
operations. 

Perform a sensor 
check 

Disarmed  

The motors are not yet armed but 
the autopilot is now ready for 
motors to be armed. 

Arm the motors 

Spool Up  

This state is intended to give the 
motors time to spool up and the 
props to begin spinning in a stable 
manner. 

Wait for the timer to 
finish counting down 

Ready for Flight  
The autopilot is waiting for a control 
input in order to take off. 

Take off 

Climb Out  

This state is active until the aircraft 
can reasonably assume that it is off 
the ground and in stable flight. 

Wait for the autopilot to 
sense that it is airborne 

Airborne  

The autopilot senses that it is in the 
air and will follow flight commands. 

Land autonomously or 
land and disarm in 
Manual or Position 
mode 

Airborne 
without GPS  

The autopilot senses that it is in the 
air without GPS and will only fly in 
ALT or Manual modes. 

Regain GPS or land 

Landing  
Autonomous landing has been 
requested and is being executed. 

Finish landing 

Landed  
Complete any user-configured post-
flight tasks, such as committing 
unsaved data to flash. 

Wait for tasks to be 
completed 
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Flight State Flow 
The autopilot will boot up in the Preflight state. During this state, the operator is expected to perform any 
pre-flight tasks and ensure that the aircraft is ready to begin flight operations. The motors are unable to 
arm and the aircraft is generally considered safe. To exit this state, the operator will need perform a sensor 
check via the virtual cockpit or hand controller. Once the sensors have been checked, the aircraft will exit 
the Preflight state and enter the Disarmed state.  

In the Disarmed state, the autopilot is waiting for the motors to be armed. Once the motors are armed, the 
aircraft will enter the Spool Up state. This flight state only lasts a few seconds and is intended to give the 
motors time to spool up and the props to begin spinning in a stable manner.  

After the Spool Up state, the autopilot will progress to the Ready for Flight state. At this point, the 
autopilot is waiting for a control input in order to take off. If the operator were to disarm the autopilot in 
this state, it would go back to the Disarmed flight state. Once a takeoff is requested or the throttle is 
advanced via the Handcontroller, the flight state enters the Climb Out state.  

This state is active until the aircraft can reasonably assume that it is off the ground and in stable flight. 
During the brief Climb Out state, throttle/altitude inputs from the user are ignored.  

Next, the aircraft enters the Airborne or Airborne without GPS state, depending upon whether or not the 
autopilot has GPS lock. The vehicle stays in the Airborne state until either an autonomous landing is 
requested or the vehicle is disarmed. If an autonomous landing is requested, the vehicle enters the 
Landing flight state. Once the vehicle is disarmed, or an autonomous landing has completed, the vehicle 
enters the Landed state.  

The Landed state lasts long enough for the vehicle to complete any user-configured post-flight tasks, such 
as committing unsaved data to flash. Once the post-flight tasks have completed, the vehicle moves to back 
to the Disarmed state. 

The figure below shows the flow from one flight state to the next. 

 
Flight State Flow.
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Appendix B: Guidance Modes 
Mode Description 

Takeoff 
After climbing to the altitude specified in Default WP Trans Alt (on the K3 
Guidance settings screen, under Modes), it flies to the location specified in the 
Takeoff waypoint while climbing to the altitude specified in the Takeoff 
waypoint. 

Land 

The button has two different click points that are separated by a dividing line. 
When clicked to the left of the dividing line, the Takeoff mode is set to Land 
Now. When depressed to the right of the dividing line, a separate menu is 
displayed allowing for different takeoff commands. The command is not sent 
to the autopilot until a second click on the menu is performed. 
   Land Now: Descent at the current location. After touching down, the throttle 

is turned off. 
   Waypoint Land: Fly at the current altitude to the Landing waypoint. Then 

descend. After touching down, the throttle is turned off. 
Hover Now Holds current altitude and position. 

Home 
Flies to the Home location at the current altitude and then holds that position. 
If the UAV is below the “minimum go-home altitude,” it will climb to that 
altitude before proceeding home. 

Rally Flies to the Rally waypoint at the current altitude and then holds that position. 
Manual Position, yaw, and climb rate are controlled by the gamepad. 
Altitude Position, yaw, and altitude are controlled by the gamepad. 

Nav Flies to each waypoint in Flight Plan according to waypoint parameters. 
Safe Prevents the motor/engine from throttling up under any circumstances. 

RC Mode (all other 
modes grayed- out) 

Autopilot disables high-level and most low-level control, giving stick-to-surface 
control to the pilot via the RC controller. Rate damping is still added in for 
additional stability in flight. When RC Mode is disabled, autopilot resumes in 
whatever mode it was in before RC Mode was enabled. RC Mode is enabled 
via the channel 5 switch on RC controller. 
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Appendix C: 3DR Modem 
Equipment Checklist 
1. 3DR radio for the ground station. 

2. 3DR radio for the vehicle. 

3. USB cable for 3DR. 

4. 3DR Radio Configuration Tool (download from http://ardupilot.com/downloads/?did=89). 

Configuring a New 3DR 
NOTE: The 3DR radios included with the Indago system should come preconfigured for use. All that 
will need to be done is change the channels on both radios to the preferred channel. The following are 
steps to take upon acquiring a new factory default 3DR radio. 

1. Using the USB cable, plug in the 3DR modem that will be used for the vehicle into the computer. 

NOTE: If the computer does not recognize the 3DR modem when plugged in, then install the drivers 
which can be found online at http://www.ftdichip.com/Drivers/VCP.htm 

2. Open the 3DR Radio Configuration Tool. 

3. Select the correct comm port and set the baud rate to 57600. 

4. Click the Load Settings button. 

 

  

http://ardupilot.com/downloads/?did=89
http://www.ftdichip.com/Drivers/VCP.htm
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5. Change the settings on the 3DR so that the Baud is 115, Air Speed is 96, Mavlink is RawData , Op 
Resend is unchecked, and the Net ID is set to the channel the user wants. 

 

6. Click on the Save Settings button. 

7. Change the ComPort Baud rate to 115200 to regain comunication with the 3DR. 

8. Click Load Settings to confirm that the changes were properly saved. 

 

9. Unplug the vehicle’s 3DR from the USB and plug in the ground station 3DR. 

10. Repeat steps 3 and 4 for this radio.  

11. Change the settings on the 3DR so that the Baud is 115, the Air Speed is 96, the Op Resend is 
unchecked, and the Net ID is set to the same channel as in Step 5. 
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12. Plug in a battery into the Indago to power the vehicle side 3DR. 

13. Watch for the groundstation side 3DR to have a solid green LED. This will idicate that the modem 
has established link. 

14. Click on Load Settings to verify communication from both modems. The settings should match the 
screen shot below. The modems are now properly configured for use. 
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Changing Channels on the 3DR 
NOTE: This section assumes using the 3DR modem(s) preconfigured for use with the Indago system. All 
that will need to be done is change the channels on both radios to the preferred channel as discussed 
below. If acquiring a new factory default 3DR radio, follow the directions listed at the beginning of this 
section.  

1. Using the USB cable, plug in the 3DR modem to be used for the vehicle into the computer. 

2. Open the 3DR Radio Configuration Tool. 

3. Select the correct comm port and set the baud rate to 115200. 

4. Click the Load Settings button. 

 
5. Change the Net ID to the channel chosen. 

6. Click the Save Settings button. 

 

7. Click the Load Settings button to confirm that the channel was saved. 

8. Unplug the vehicle 3DR modem from the USB cable and plug it into the ground station 3DR. 

9. Repeat steps 3-7 for the ground station 3DR. 

10. Plug in a battery into the Indago to power the vehicle side 3DR. 
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11. Watch for the groundstation side 3DR to have a solid green LED. This will indicate that the modem 
has established link. 

12. Click on Load Settings to verify communication from both modems. The modems are now ready for 
use. 
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Communication with Virtual Cockpit and the 3DR Modem 
1. Open Virtual Cockpit. 

2. Press F7 and navigate to the Comm and XML Settings page. 

3. Make sure the Baud is set to 115200 and open the correct comm port for the 3DR. 

  
4. Verify communication with the 3DR modem by hitting F6 and navigating to the 3DR Modems page 

and looking to see that the values populate.  
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Appendix D: Service Bulletins and Notes 
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